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How to Contact Oracle Technical Publications
Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this 
publication. We also welcome your comments regarding our documentation delivery format. Your 
input is an important part of the information used for revision.

■ Did you find any errors?
■ Is the information clearly presented?
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■ Are the examples correct? Do you need more examples?
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number (if available) in your e-mail.

Send your comments to ntdoc@us.oracle.com

Other Ways to Contact Oracle Corporation
Depending on your need for information, one or more of these sources may be valuable to you: 

Location Contact

Oracle Corporation Home Page http://www.oracle.com

Oracle World Wide Support (on the World Wide Web) http://www.oracle.com/support/ 

Oracle World Wide Support in the United States of 
America (by telephone)

■ (1) (650) 506-1500 (for customers with support 
contracts)

■ (1) (650) 506-5577 (to obtain a support contract)

Oracle World Wide Support International Your local support center in your country
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Preface

This guide provides operating system-specific information on using Oracle Parallel 
Server for Windows NT. This preface provides information about:

■ Intended Audience

■ Prerequisites

■ Structure

■ Related Documents

■ Conventions Used in this Guide
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Intended Audience
This guide is for network administrators and database administrators who install, 
configure, and use Oracle Parallel Server on Windows NT clusters.

Prerequisites
This guide assumes you are familiar with:

■ Windows NT and have installed and tested it with network hardware

■ Oracle7 relational database concepts

Structure
This guide contains the following chapters and appendices.

Chapter 1 Overview of Oracle Parallel Server
Describes the main features of Oracle Parallel Server.

Chapter 2 System Requirements
Describes the specific hardware and software requirements for installing Oracle 
Parallel Server.

Chapter 3 Performing Pre-Installation Tasks
Guides you through necessary pre-installation tasks

Chapter 4 Installing
Describes how to install Oracle7 Server and Oracle Parallel Server.

Chapter 5 Configuring
Describes how to configure an Oracle Parallel Server.

Chapter 6 Installing and Configuring Oracle Enterprise Manager
Describes the tasks to install and configure Oracle Enterprise Manager and 
Performance Manager for parallel servers.
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Chapter 7 Administering Multiple Instances
Describes Oracle Parallel Server initialization files and Oracle Parallel Server 
Manager.

Chapter 8 Handling Migration Issues
Describes how to add a third or fourth node to an existing cluster, and how to 
migrate from an single-instance database to multiple instances.

Chapter 9 Backing Up and Recovering an Oracle Parallel Server Database
Describes NT Backup Manager and the NT Recovery Manager for Oracle Parallel 
Server.

Appendix A Directory Structure
Lists default directory structures for Oracle Parallel Server on Windows NT.

Appendix B Troubleshooting
Describes how to resolve Oracle Parallel Server problems.

Related Documents
For more information, see the following guides:

■ Oracle7 Server Getting Started for Windows NT

■ Oracle7 Parallel Server Concepts and Administration

■ Oracle Enterprise Manager Administrator’s Guide

■ Oracle Parallel Server Support for the Oracle Enterprise Manager Console
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Conventions Used in this Guide
Note these typographical conventions when reading this guide:

Convention Example Meaning

All uppercase plain ORANT\DATABASE\INITOPS1.ORA Indicates command names, SQL 
reserved words, and keywords as in 
ALTER DATABASE. All uppercase plain 
is also used for directory names and file 
names.

Italic Italic used to indicate a variable:

C:\ORACLE_HOME\filename\

Italic used for emphasis:

The WHERE clause may be used to join 
rows in different tables.

Indicates a value that you must provide. 
For example, if a command asks you to 
type filename, you must type the actual 
name of the file.

Italic is also used for emphasis in the 
text and to indicate the titles of other 
guides.

Horizontal ellipsis ... CHKVAL fieldname value 1 value 
2... valueN

Indicates that parts of the statement or 
command not directly related to the 
example have been omitted.

Vertical bar | ..DEFINE [  macro1 | macro2 ] Represents an ‘or’ option between 
several options. You must enter only one 
of the options. Do not enter the vertical 
bar. The set of alternative choices is 
enclosed by curly braces if one of the 
items is required, or by square brackets 
if the item is an optional alternative.

Curly braces {} ..DEFINE {  macro1 | macro2 } Encloses required items. You must 
choose one of the alternatives.

Square brackets [ ] CVTCRT termname [outfile] Encloses optional items. You can choose 
one or none of the alternatives. 

Square brackets also indicate a function 
key, for example [Enter].

C:\> C:\ORANT\DATABASE Represents the Windows NT command 
prompt of the current hard disk drive. 
Your prompt may differ and may, at 
times, reflect the subdirectory in which 
you are working. Referred to as the MS-
DOS command prompt in this manual.
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Oracle home Go to the ORACLE_HOME\DATABASE 
directory.

SVRMGR> 
@%ORACLE_HOME%\RDBMS73\ADMIN\CATALOG.SQL

Oracle home is the top level directory 
and the drive letter where your Oracle 
software is installed. By default, the 
Oracle home directory for Windows NT 
products is ORANT and for Windows 95 
products is ORAWIN95. In this guide, 
the convention ORACLE_HOME is used 
to indicate your Oracle Home directory, 
which may be ORANT, ORAWIN95, or 
whatever you may have called your 
Oracle home.

In Server Manager commands you may 
see %ORACLE_HOME%. Server 
Manager is able to locate your Oracle 
Home directory using the  
%ORACLE_HOME% variable. This 
convention can be used in Server 
Manager and SQL*Plus.

Backslash (\) before 
a directory name

 \DATABASE Indicates that the directory is a 
subdirectory.

Symbols period  .

comma  ,

hyphen  -

semicolon  ;

colon  :

equal sign  =

backslash  \

single quote  ‘

double quote  “

parentheses ()

Symbols other than brackets and vertical 
bars must be entered in commands 
exactly as shown.

Convention Example Meaning
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1
Overview of Oracle Parallel Server

This chapter provides a conceptual overview of Oracle Parallel Server. This 
information helps you prepare and plan your Oracle Parallel Server installation. 

Specific topics covered in this chapter are:

■ Introduction

■ Oracle Parallel Server Overview

■ Oracle Parallel Server Instances and Nodes

■ Oracle Parallel Server Manager

■ Operating System Dependent Layer
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Introduction
Oracle Parallel Server is a hardware architecture that allows multiple instances 
access to a shared database. Oracle Parallel Server offers the following (terms will 
be described later in this chapter):

■ Superior scalability through distribution of workload across nodes

■ High-availability through multiple nodes accessing the database; if one node 
fails, the database is still accessible through surviving nodes

An Oracle Parallel Server can handle node or disk failure in a clustered 
environment with no or minimal downtime. The Oracle Parallel Server architecture 
provides the following features:

■ Separate Oracle instances running on different nodes operate against a set of 
common database files that reside on shared disks physically accessible by all 
nodes that make up the cluster.

■ All instances can execute transactions concurrently against the same database, 
and each instance can have multiple users executing transactions concurrently.

Coordination of each node accessing the shared database provides the following:

■ Data consistency and integrity

■ Data and lock recovery support 

The following installable components make up an Oracle Parallel Server:

■ Oracle7 Server

■ Oracle Parallel Server Option

■ Oracle Parallel Server Manager

■ Operating System Dependent modules
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Oracle Parallel Server Overview
An Oracle Parallel Server consists of multiple Oracle instances that access the same 
database. Oracle Parallel Server runs from a cluster, whereby multiple nodes running 
different instances can share all of the data in a single database.

A cluster is a parallel system that consists of a collection of interconnected nodes and is 
utilitzed as a single computing resource. A node is a Windows NT server where an 
instance resides. A cluster can contain a maximum of four nodes.

A cluster consists of the following hardware, software and environment components:

Hardware
■ One or more machines, each physically connected.

■ A shared disk storage subsystem.

Software
■ An instance on each node that participate together to access a common database. 

Oracle Parallel Server instances are also referred to as a domain. Each node in the 
domain uses a unique system identifier (SID) to identify its instance. 

The first node, called the primary node, uses the SID OPS1; the second node uses 
the SID OPS2 to identify its instance; and so on.

■ An instance with at least the following five background processes: PMON, SMON, 
LCK0 (it is possible to have more than one LCK process), DBWR, and LGWR.

■ A Distributed Lock Manager (DLM) on each node to provide a locking mechanism.

■ Operating System Dependent (OSD) vendor software layer

Environment
■ A unique combination of environment variables, including ORACLE_SID and 

ORACLE_HOME, that specify operation parameters for each particular instance.

Note: All nodes are equal in components. The primary node is 
simply just the first node in cluster.

Additional Information: For more information on Oracle7 Server 
processes and memory structures, see Oracle7 Server Concepts.
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Oracle Parallel Server Instances and Nodes
Oracle Parallel Server allows multiple instances to coordinate data manipulation 
operations on a common database. An Oracle Parallel Server instance is defined as a 
process and a set of threads and memory structures required for proper database 
operation. The pool of threads that make up an instance coordinate their work on the 
database through shared memory by means of the instance Shared Global Area (SGA). All 
processes belonging to the instance exist on the same node. Users can connect to any 
instance to access the information that resides within the shared database.

In an Oracle Parallel Server model, multiple instances participating on multiple nodes in a 
cluster mount the same database files. The database files are located on disk drives that 
are shared between the multiple nodes. If one node fails, client applications can re-route 
users to another node. The surviving node automatically performs recovery by rolling 
back any incomplete transactions that the other node was attempting. This ensures the 
logical consistency of the database.

Database Files
A database is logically divided into tablespaces that contain all data stored in the 
database. Tablespaces, in turn, are made up of one or more data files.

With Oracle Parallel Server, all participating instances access the same database files.

Note: An instance does not include database files. This means 
you can start up an instance without mounting the database files.
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Figure 1–1 shows the relationship between two Oracle instances and the shared 
disks on which the database files are stored:

Figure 1–1 Oracle Parallel Server Instance Architecture

PGMS
The Group Membership Service (PGMS) called OraclePGMSService monitors 
instances on nodes. OraclePGMSService interacts with the Cluster Manager — the 
vendor software that manages access to shared disks and monitors the status of 
various cluster resources (including nodes, networks, and the PGMS). The Cluster 
Manager provides a node monitor service (as described in “Cluster Manager” in 
this chapter), which each PGMS uses to determine the status of GMS instances on 
other nodes. Each instance attaches to the OraclePGMSService during startup. An 
instance detaches from the OraclePGMSService during shutdown.

Oracle Instance OPS1

SGA

Oracle Instance OPS2

SGA

Node 1 Node 2

Background Processes Background Processes

Shared Disks With Common Database Files

All nodes have equal 
access to all disks.
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Distributed Lock Manager
Because Oracle Parallel Server has multiple instances sharing a database on a shared-disk 
subsystem, an integral part of its operation involves managing the access to shared 
database resources. The Distributed Lock Manager (DLM) component of Oracle Parallel 
Server provides this functionality. The DLM:

■ Provides a locking mechanism to control allocation and modification of Oracle 
resources, such as data blocks and rollback segments, across multiple instances.

■ Performs deadlock detection.

■ Provides a level of failure detection and recovery.

■ Synchronizes modifications made to the Oracle database files so that no changes are 
lost.

■ Synchronizes disk block access between multiple nodes.

The DLM is a resource manager and, thus, does not control access to the database.



Oracle Parallel Server Instances and Nodes

                                                                   Overview of Oracle Parallel Server 1-7

Figure 1–2 shows the relationship between two Oracle instances, the DLM software, 
and shared disks.

Figure 1–2 DLM Architecture

Example  A node in a cluster needs to modify block number n in the database file. At 
the same time, another node needs to update the same block n to complete a 
transaction.

Without the DLM, both nodes update the same block at the same time. With the DLM, 
only one node is allowed to update the block. The other node must wait. The DLM 
ensures that only one instance has the right to update a block at any one time. This 
provides data integrity by ensuring that all changes made are saved in a consistent 
manner.

Interaction with PGMS  The DLM uses PGMS to determine which instances are active. 
When the OracleServiceSID service is started, each DLMON (DLM monitor) thread 
(there is one DLMON thread per instance) connects to PGMS. When a membership 
change notification is received, DLMON initiates a reconfiguration procedure. 

Distributed
Lock Manager

Oracle
Instance OPS1

Oracle
Instance OPS2

Distributed
Lock Manager

Interconnect

Shared Disks With Common Database Files
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Parallel Cache Management
Parallel Cache Management (PCM) is the facility by which Oracle Parallel Server 
provides locks (with minimal use of the DLM) maintains similar database buffers 
in each instance.

Example  If node 1 needs access to data that is currently node 2’s buffer cache, 
node 1 can submit a request to the DLM. Node 2 then writes the needed blocks to 
disk. Only then is Node 1 notified by the DLM to read updated and consistent data 
from the disk. 

PCM Lock Implementation
PCM locks are implemented in two ways:

Hash Locking  When hash locking is used, there is a fixed assignment of PCM 
locks to datafiles. Locks are allocated statically at instance startup time. When fine-
grain locking is used, locks are dynamically allocated when needed (that is, at 
block-access time). Hash locking offers the advantage of no overhead for lock 
allocation when a data block is accessed. The total number of locks that can be 
allocated is limited by system resources. This usually means that multiple blocks 
have to be covered by the same lock. In other words, there is a low lock granularity. 

PCM Lock Description

hash locking This is the default implementation, in which PCM locks 
are statically assigned to one or more blocks in the 
datafiles.

fine-grain locking One PCM lock per block is assigned on a dynamic basis.

Additional Information: Fine-grain locking is configured by 
setting the _ENABLE_DBA_LOCKING parameter to TRUE (the 
default is FALSE) and any of the GC_* parameter values in the 
INIT_COM.ORA to 0, as described in “Setting Initialization 
Parameters for the Oracle Parallel Server” in Chapter 7, 
“Administering Multiple Instances”. 

It is possible to have both fine-grain locking and hash locking 
enabled at the same time.
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This might result in false pinging. The startup of the instance also requires more time, 
since all the lock resources have to be allocated at startup time.

Fine-Grain Locking  With fine-grain locking, locks are dynamically allocated at block-
access time. The resources for the lock are only allocated during the time the lock is 
needed and are released when the lock is released. This makes it possible to achieve very 
high-lock granularity. If resource minimization is the goal, fine-grain locks can also cover 
multiple blocks, but are still allocated dynamically.

Below is a comparison of both PCM locks. 

Choosing a Lock
Use the table below to choose a PCM lock:

Hash PCM Locks Fine-Grain PCM Locks

■ Allocated at instance startup, 
resulting in a slower startup.

■ Allocated when user requests a block, resulting 
in faster instance startup.

■ Released only at instance 
shutdown.

■ Dynamically re-used by other blocks, requiring 
less memory.

■ Statically hashed to blocks at 
startup time, requiring more 
memory.

When to Use Hash Locking When to use Fine-Grain Locking

■ Data is mostly read-only. ■ Small amount of data is updated by many 
instances.

■ Data can be partitioned. ■ There is not enough memory for the 
configuration of hash locking.

■ Large set of data is modified 
by a relatively small set of 
instances.
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Parallel Query
With the Parallel Query Option (OPQ), Oracle can divide the work of processing 
certain types of SQL statements among multiple query server processes.

Architectural Overview
When parallel execution is not being used, a single server thread performs all 
necessary processing for the sequential execution of a SQL statement. For example, 
to perform a full table scan (such as SELECT * FROM EMP), one thread performs 
the entire operation.

OPQ performs the operations in parallel using multiple parallel processes. One 
process, known as the parallel coordinator, dispatches the execution of a statement to 
several parallel slave processes and coordinates the results from all of the slave 
processes to send the results back to the user. 

The parallel coordinator breaks down execution functions into parallel pieces and 
then integrates the partial results produced by the parallel slave processes. The 
number of parallel slave processes assigned to a single operation is the degree of 
parallelism for an operation. Multiple operations within the same SQL statement 
all have the same degree of parallelism

OPQ on Oracle Parallel Server
Oracle Parallel Server provides the framework for the Parallel Query Option to 
work between nodes. The Parallel Query Option behaves the same way in Oracle 
with or without the Parallel Server Option. The only difference is that OPS enables 
OPQ to ship queries between nodes so that multiple nodes can execute on behalf of 
a single query. Here, the server parallelizes the query by decomposing it into 
smaller operations which run against a common database which resides on shared 
disks. Because it is performed by the server, this parallelism can occur at a low level 
of server operations, rather than at an external SQL level. 

In some applications, an individual query often consumes a great deal of CPU 
resource and disk I/O (unlike most online insert or update transactions). To take 
advantage of multiprocessing systems, the data server must parallelize individual 
queries into units of work which can be processed simultaneously. 

If the query were not processed in parallel, disks would be read serially with a 
single I/O. A single CPU would have to scan all rows in a table. With the query 
parallelized, disks are read in parallel, with multiple I/Os.
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Several CPUs can each scan a part of the table in parallel, and aggregate the results. 
Parallel query benefits not only from multiple CPUs but also from more of the 
available I/O bandwidth.

OPQ can run with or without the Oracle Parallel Server option. Without the Oracle 
Parallel Server option, OPQ cannot perform mult-node parallelism. The parallel 
server option optimizes Oracle7 to run on clustered hardware, using a parallel 
cache architecture to avoid shared memory bottlenecks in OLTP and decision 
support applications. 

OPQ Statement
OPQ within Oracle Parallel Server performs parallelism within a node and among 
nodes via the parallel slave processes on each node. 

A sample SQL statement is shown below:

After you have run a query, you can use the information derived from 
V$PQ_SYSSTAT to view the number of slave processes used, and other information 
for the system.

Note: Parallelism is used only as hint and not as a requirement.

Additional Information: See Chapter 13,”The Parallel Query 
Option on OPS”, of the Oracle7 Parallel Server Concepts and 
Administration.

SELECT /*+ PARALLEL <OBJ$, 2, 2> */ * FROM OBJ$;

parallel query statement

parallelism within node(s)

parallelism between node(s)
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Oracle Parallel Server Manager
The Oracle Parallel Server Manager (OPSM) provides a single point for starting, 
stopping, and monitoring the activity of parallel servers and parallel server 
instances from the command line or from within Oracle Enterprise Manager (EM).

Operating System Dependent Layer
A vendor-supplied Operating System Dependent (OSD) layer must be installed 
after Oracle Parallel Server Option is installed. The OSD layer consists of several 
software components developed by vendors. The OSD layer maps the key OS/
cluster-ware services required for proper operation of Oracle Parallel Server.

OSD Components
The OSD layer consists of:

These components provide key services required for proper operation of the Oracle 
Parallel Server Option and are used by various clients, such as PGMS and DLM. 
Each OSD module interacts with the Oracle Parallel Server runtime environment as 
a single Dynamic Link Library (DLL). These components are more fully described 
later in this chapter.

Additional Information: See Chapter 7, “Administering Multiple 
Instances” for more information about Oracle Parallel Server 
Manager.

Component Description

Cluster Manager 
(CM) 

Discovers the state of the cluster.

Inter-Process 
Communication (IPC)

Provides reliable transfer of messages between instances on 
different nodes.

Input/Output (IO) Provides I/O to access shared disks.

Startup (START) Provides one-time configuration to startup functionality.

Performance and 
Management (P&M)

Supports external performance and management tools.
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Figure 1–3 illustrates the OSD components in a cluster with two nodes:

Figure 1–3 OSD Components
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Cluster Manager
The Cluster Manager (CM) component:

■ Provides the basic node management interface modules needed by Oracle 
Parallel Server in a cluster environment. 

■ Allows the Oracle Parallel Server environment to discover and track the 
membership state of nodes by providing a common view of cluster 
membership across the cluster. 

■ Runs on all nodes and monitors the topology of the cluster by querying all 
nodes for their current membership. Note this is different than PGMS, where 
monitoring occurs at the instance level rather than the node level.

■ Detects changes in the state of active nodes signaling those events, diagnosing 
the changes, and coordinating a new common and consistent state among all 
nodes. 

■ Notifies Oracle Parallel Server of the actual changes to membership.

It is critical that all Oracle Parallel Server instances receive the same membership 
information when events occur. Notification changes cause relevant Oracle Parallel 
Server recovery operations to be initiated. If any node is determined to be dead or 
otherwise not a properly functioning part of the system, CM terminates all 
processes on that node. Thus, any process or thread running Oracle code can safely 
assume its node is an active member of the system.

If there is a failure, recovery is transparent to user applications. CM automatically 
reconfigures the system to isolate the failed node and notify system services (for 
instance the DLM) about the status. The DLM subsequently recovers any of the 
locks from the failed node. Oracle Parallel Server can then recover the database to a 
valid state. 

The DLM relies on the Cluster Manager for timely and correct information. If the 
DLM cannot get the information it needs, it will shut down the instance.
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Inter-Process Communication (Node-to-Node)
Oracle Parallel Server derives most of its functional benefits from its ability to run 
on multiple interconnected machines. Oracle Parallel Server relies heavily on the 
underlying Inter-Process Communication (IPC) component to facilitate this. 

IPC defines the protocols and interfaces required for the Oracle Parallel Server 
environment to transfer reliable messages between instances. Messages are the 
fundamental logical units of communication in this interface. The core IPC 
functionality is built around an asynchronous, queued messaging model. IPC is 
designed to send/receive discrete messages as fast as the hardware allows. With an 
optimized communication layer, various services can be implemented above it. 
This is how the DLM carries out all of its communication.

Input/Output
The Input/Output (IO) component provides interprocess capabilities that a cluster 
implementation must support to enable proper operation of the Oracle Parallel 
Server environment.

The Oracle Parallel Server environment is extremely dependent on the ability of the 
underlying OS/cluster implementation to support simultaneous disk sharing 
across all nodes that run coordinated Oracle Parallel Server instances. Unlike 
switch-over based technologies, all Oracle Parallel Server instances are active and 
can operate on any database entity in the shared physical database simultaneously. 
It is this capability that gives Oracle Parallel Server a large portion of its parallel 
scalability. It is the role of the DLM to coordinate the simultaneous access to shared 
databases in a way that maintains all consistency and data integrity.

At a high level, the Oracle Parallel Server shared I/O model can be described as a 
distributed disk cache implemented across all nodes that define the Oracle Parallel 
Server cluster. The core of Oracle Parallel Server can be viewed as a major client of 
the cache. Disk blocks from the shared devices are read into a particular node 
instance cache only after mediation by the DLM. The other node instance may read 
the same blocks into its cache and operate on them simultaneously. Updates to 
those blocks are carefully coordinated. In general, all shared disk based I/O 
operations are mediated by the DLM. The set of distributed DLMs on each node 
can be thought of as managing the distributed aspects of the cache.

Disk update operations must be carefully coordinated so that all nodes see the 
same data in a consistent way. Any Oracle Parallel Server instance intending to 
update a cached data block must enter into a dialog with the DLM to ensure it has 
exclusive right to update the block. Once it does this, the instance is free to update 
the block until its rights have been revoked by the DLM. When the exclusive 
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update right is revoked, the instance with block updates must write the block to 
disk so that the other node can see the changes. Given this rather high-level view of 
the DLM I/O consistency model, it is clear that disk blocks can migrate around to 
each instance’s block cache and all updates are flushed to disk when an instance 
other than the owner desires access to the block. It is this property that directly 
determines the reliance of Oracle Parallel Server on shared disk implementations.

Startup
The Startup (START) component initiates the Oracle Parallel Server components in 
a specific order during instance startup. For example, the DLM is started before any 
other Oracle Parallel Server components are allowed to access the physical 
database.

Performance and Management
The Performance and Management (P&M) component defines the way Oracle 
Parallel Server clients are configured and the relevant information an OSD 
implementation must provide to allow the Oracle management tools to operate 
properly. The P&M component also defines the way OSD modules provide 
performance analysis information suitable for OPSM.
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2
System Requirements

This chapter describes the system requirements of Oracle Parallel Server.

Specific topics covered in this chapter are:

■ Hardware Requirements

■ Software Requirements

■ Shared Disk Subsystem
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Hardware Requirements

Node Requirements
Each node in a cluster requires the following hardware:

■ A personal computer (PC) with Intel 80486 or Pentium/Pentium Pro processor

■ Windows NT-compatible network interface card (NIC). The NIC must be 
supported by Microsoft

■ External hard disk

■ Connected CD-ROM drive, functioning as a logical drive

■ 96 MB RAM or more

Oracle Enterprise Manager Repository Database Requirements
Dedicate a PC with Windows NT (fulfilling the above node requirements) as the 
repository database with a minimum of 32 MB use Oracle Enterprise Manager 
(EM).

Oracle Enterprise Manager Console Requirements
Additionally, a Windows NT or Windows 95 console (or client machine) where 
Oracle EM resides requires the following hardware: 

■ Intel 486 PC or better 

■ Windows NT or 95 compatible network adapter 

■ VGA video (SVGA strongly recommended) 

■ Connected CD-ROM drive, functioning as a logical drive.

■ 31 MB RAM recommended for Oracle EM

■ 15 MB RAM for the Oracle EM Performance Pack (optional) 
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Software Requirements

Node Requirements
Each node in a cluster requires the following software:

■ Windows NT 4.0 Server

■ Microsoft TCP/IP

■ Oracle7 Server release 7.3.4

■ Oracle7 Parallel Server Option release 7.3.4 (including Oracle Parallel Server 
Manager Server)

■ Operating System Dependent (OSD) layer

■ SQL*Net Server version 2.3.4 to accept client connections and to make server-to-
server connections.

■ One of the following Web browsers to view online documentation:

– Netscape Navigator Version 3.0. Visit: http://www.netscape.com

– Microsoft Internet Explorer Version 3.0. Visit: http://www.microsoft.com

Oracle Enterprise Manager Repository Database Requirements
Oracle EM repository database machine requires:

■ Oracle7 Server release 7.3.4

■ SQL*Net Server version 2.3.4 to accept client connections and to make server-to-
server connections.

Oracle EM Console Requirements
The Oracle EM console workstation requires:

■ Oracle Enterprise Manager release 1.3.6.

■ Oracle7 Parallel Server Option release 7.3.4 (including Oracle Parallel Server 
Manager Client)

■ SQL*Net Client version 2.3.4
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Shared Disk Subsystem
Oracle Parallel Server requires a shared disk subsystem to contain shared partitions 
that are raw. All Oracle7 data, log, and control files are placed on shared raw 
partitions.

Note: Each instance of an Oracle Parallel Server database has its 
own log files, but control files and data files are shared by each 
instance in the cluster. However, log files must be accessible/
readable by other instances.
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3
Performing Pre-Installation Tasks

This chapter describes required pre-installation tasks.

Specific topics covered in this chapter are:

■ Raw Partition Overview

■ Step 1: Create an Extended Partition

■ Step 2: Create Logical Drives In an Extended Partition

■ Step 3: Unassign Drive Letters
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Raw Partition Overview
Because no true distributed file system support exists on Windows NT, the 
mechanism Oracle uses to allow nodes running different instances to access shared 
disks is to bypass the NT file system by using raw partitions. The shared disks are 
then a collection of unformatted raw devices.

Raw Partition  A raw partition is a portion of a physical disk that is accessed at the 
lowest possible level. I/O to a raw partition offers approximately a 5% to 10% 
performance improvement over I/O to a partition with a file system on it.

A raw partition is created when an extended partition is created and logical drives 
are assigned to it without applying any formatting. The Windows NT Disk 
Administrator application allows you to create an extended partition on a physical 
drive. 

Extended Partition  An extended partition points to raw space on the disk that can 
be assigned multiple logical drives for the database files. An extended partition 
avoids the four-partition limit by allowing you to define large numbers of logical 
drives to accommodate applications using Oracle7 Server. Logical partitions can 
then be given symbolic link names to free up drive letters. We create an extended 
partition in this chapter and link the drive letters to symbolic link names in 
Chapter 5, “Configuring”.
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The Disk Administrator window shown below shows four disks, two of the disks 
having an extended partition:

Figure 3–1 Disk Administrator

This disk.... Contains...

Disk 0 a primary partition

Disk 1 an extended partition with six logical drives and 246 MB of free space

Disk 2 an extended partition with three logical drives and 1146 MB of free 
space

Disk 3 an unformatted partition

Note: You can tell whether a partition is formatted or 
unformatted by the direction of the diagonal lines. A formatted 
partition’s lines display from top left to the bottom (\\), and an 
uninitialized partition’s lines display from top right to the bottom 
(//).

2 extended 
partitions,
1 per disk

primary partition
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Disk Definition   Windows NT defines each disk drive found at startup with the 
following naming convention:

\Device\Harddiskm\Partitionn

where m is the number of the physical drive, and n is a drive number (logical drive 
number) as shown in the Disk Administrator’s window (in Figure 3–1). 

The first logical drive (E:) defined on the second physical drive in the section “Step 
2: Create Logical Drives In an Extended Partition” has the following entry:

\Device\Harddisk1\Partition1

The first logical drive on a system (normally the C drive) has the following entry:

\Device\Harddisk0\Partition1

Partition0 has special meaning in that it has access to the whole disk.

Raw Partition Definition  Raw partitions are of two types:

■ logical drive

Partition created by the Disk Administrator that point to a drive other than 
Partition0.

■ physical drive

Partition that points to Partition0. Windows NT automatically creates a 
symbolic link name of \\.\PhysicalDrivex (where x is the physical drive 
number) to \Device\Harddiskx\Partition0. The x in \\.\PhysicalDrivex 
matches the x in \Device\Harddiskx\Partition0.

Note: Although you can use physical drives, Oracle Corporation 
recommends using logical drives and creating symbolic links (as 
described in section “Step 1: Assign Symbolic Links to Each 
Logical Drive” in Chapter 5, “Configuring”).
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Step 1: Create an Extended Partition
Only one extended partition can be created per disk. You can use the free space in 
the extended partition to create multiple logical drives or use all or part of it when 
creating volume sets or other kinds of volumes for fault-tolerance purposes.

To create an extended partition:

1. Shut down all nodes except the primary node.

2. On the primary node, choose Start>Programs>Administrative Tools>Disk 
Administrator.

The Disk Administrator window appears:

Note the lines display diagonally from top right to the bottom left, indicating 
unpartitioned devices.

3. Select an area of free space in an extended partition on a disk that is on the 
shared disk subsystem by clicking the mouse.

Oracle recommends you use the entire disk.

4. Choose Create Extended... from the Partition menu.
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The Disk Administrator displays the minimum and maximum sizes for the 
extended partition:

5. Use the default maximum size, and then choose OK.

The extended partition is created.

Note the lines now display diagonally from top left to bottom right, indicating 
the partition is an extended partition.

Note: Changes you have made are not saved until you choose 
Commit Changes Now or quit the Disk Administrator.
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Step 2: Create Logical Drives In an Extended Partition
After an extended drive is created, you must assign logical drives to it. Logical 
drives are assigned letters of the alphabet. 

To create logical drives in an extended partition:

1. On the primary node, select an area of free space in an extended partition by 
clicking the mouse on it.

2. Choose Create from the Partition menu.

The Disk Administrator window displays the minimum and maximum sizes for 
the logical drive:

3. Enter the size of the logical drive, and then choose OK. The size is dependent 
on how large your want your log files and data files to be. Add 2MB to this size 
for overhead. If you plan on using the default database OPS.SQL creation script 
(to be used later) located in ORACLE_HOME\OPS to create your database 
later, 300 MB is more than enough.

4. Repeat Steps 1-3 until you have nine logical drives.

Additional Information: See “Step 6: Create an Oracle Parallel 
Server Database” in Chapter 5, “Configuring”, for more 
information about OPS.SQL.

ATTENTION: A two-node cluster requires 9 drives, and each 
additional node requires 2 additional drives to accommodate log 
files.
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5. Choose Commit Changes Now from the Partition menu.

A confirmation dialog appears, informing you changes have been made to the 
disk.

6. Choose Yes to acknowledge the message.

A dialog box appears, informing you the disks have been updated successfully.

7. Choose OK.

8. Choose Close from the Partition menu.

9. Reboot all of the other nodes.

10. Choose Start>Programs>Administrative Tools>Disk Administrator on all the 
nodes.

On all nodes except the primary node, a dialog box appears, informing you the 
disk configuration has been detected. If you do not see this dialog box, it does 
not mean the disk configuration has not changed. 

11. Choose OK.

The extended partition and the logical partitions are now seen by all of the 
nodes.

Note: The hard disks that access the shared area may be different 
from node to node. The logical drives, however, that reside on the 
hard disks must be identical on all nodes.
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For example, Node 1 may look like:

Figure 3–2 Node 1 Logical Partitions
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Node 2 may look like:

Figure 3–3 Node 2 Logical Partitions

On Node 1, the logical drive E is defined as \Device\Harddisk1\Partition1. On 
Node 2, it is defined as \Device\Harddisk2\Partition1. Even though these map to 
different disks, they map to the same space on the shared disk.
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Step 3: Unassign Drive Letters
To free up other drive letters for other purposes, such as mapping network drives, 
it is important to also unassign the drive letters from the logical partitions on each 
partition. Oracle Parallel Server does not need to access a partition through a drive 
letter.

To unassign drive letters: 

1. On each node, select a logical partition.

2. Choose Assign Drive Letter from the Tools menu

The Assign Drive Letter dialog box appears:

3. Choose Do not assign a driver letter and choose OK.

A confirmation dialog box appears.

4. Choose Yes to confirm change.

5. Repeat Steps 1-4 for each logical drive on each node.

Note: A two-node cluster requires 9 logical drives, for example, 
with drive letters E through M. Each additional node requires two 
additional drives to accommodate the log files.

Note: If your disks have been previously configured, the logical 
drives may already be unassigned. If this the case, you can skip to 
Step 6 of this procedure.
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6. For each node in the cluster, write down the hard disk number(s) and the 
number of the partition (starting at 1) for that drive. 

Oracle Corporation recommends using a worksheet similar to the one below:

For example, the worksheet for the Disk Administrator windows shown in 
Figure 3–2 and Figure 3–3 of this chapter would look like:

7. Choose Close from the Partition menu on all nodes.

The Disk Administrator application exits.

8. Continue to Chapter 4, “Installing”.

Note: The hard disks that access the shared area may be different 
from node to node. The logical drives, however, that reside on the 
hard disks must be identical from node to node.

Node 1 Node 2 Node 3 Node 4

Hard Diskx Partitions x-x Partitions x-x Partitions x-x Partitions x-x

Hard Diskx Partitions x-x Partitions x-x Partitions x-x Partitions x-x

Node 1 Node 2

Hard Disk1 Partitions 1-6 n/a

Hard Disk2 Partitions 1-3 Partitions 1-6

Hard Disk3 n/a Partitions 1-3
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4
Installing

This chapter describes the installation and configuration tasks to create an 
operating Oracle Parallel Server.

Specific topics covered in this chapter are:

■ Installation Overview

■ Step 1: Install Oracle7 Server and Oracle Parallel Server on Nodes

■ Step 2: Install OSD Files
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Installation Overview
Below is a a description of the Oracle Parallel Server products:

Product Description

Oracle Parallel Server 
Manager Client

Installs the files needed on the Oracle Enterprise Manager 
(EM) console to use OPSM to manage instances.

Note: This should be installed on the console workstation 
where Oracle Enterprise Manager is to be installed, as 
described in “Step 1: Install Oracle Enterprise Manager” in 
Chapter 6, “Installing and Configuring Oracle Enterprise 
Manager”. 

WARNING: Do not install Oracle Enterprise Manager after 
installing OPSM Client.

Oracle Parallel Server 
Manager

Installs the OPSM files needed to manage instances from 
individual nodes. 

Additional Information: See Chapter 9, “Backing Up and 
Recovering an Oracle Parallel Server Database”.

Oracle Parallel Server 
Option

Installs:

■ Oracle Parallel Server files

■ DLM files

■ SQL scripts and Oracle files for creating a two instance 
database

■ OraclePGMSService NT service
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Step 1: Install Oracle7 Server and Oracle Parallel Server 
on Nodes

1. Install Oracle7 Server on each of the nodes in the cluster, following instructions 
in the installation CD-ROM insert, and perform these tasks:

a. Choose None in the Starter Database Options dialog box:

b. Choose Oracle7 Parallel Server Option from the Oracle7 Server Options 
dialog box:

ATTENTION: These instructions do not discuss how to migrate 
from an Oracle7 Server to an Oracle Parallel Server. These 
instructions assume Oracle7 Server is not already installed.

Note: The location of the Oracle Home can be different on each of 
the nodes.
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2. If you plan to install Oracle Enterprise Manager on a console, ensure the Oracle 
Intelligent Agent is installed on the server nodes. The Oracle Intelligent Agent 
allows Oracle Enterprise Manager on a console to communicate with the 
database.

Step 2: Install OSD Files
To create the Oracle Parallel Server instances and the OSD registry entries:

1. For all nodes, see your OSD vendor documentation for instructions on 
installing OSD files.

2. Continue to Chapter 5, “Configuring” to configure Oracle Parallel Server 
correctly.
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5
Configuring

This chapter describes the configuration tasks to create an operating Oracle Parallel 
Server.

Specific topics covered in this chapter are:

■ Step 1: Assign Symbolic Links to Each Logical Drive

■ Step 2: Configure OSD Layer

■ Step 3: Create Services

■ Step 4: Add the ORACLE_SID Entry to the Registry

■ Step 5: Configure the Network

■ Step 6: Create an Oracle Parallel Server Database

■ Step 7: Start the Database in Parallel Mode

■ Step 8: Verify Instances Are Running



5-2 Oracle Parallel Server Getting Started Release 7.3.4 for Windows NT                                                   

Step 1: Assign Symbolic Links to Each Logical Drive
The Oracle SETLINKS utility creates symbolic links to raw logical drives.

With the SETLINKS utility, you can create a symbolic link called OPS_log1t1 to 
the second logical drive on the second physical disk:

OPS_log1t1 \Device\Harddisk2\Partition2

The SETLINKS utility comes with an ASCII file, ORALINK1.TBL, with symbolic 
link names already associated with raw partitions for a two-node cluster:

Figure 5–1 ORALINK1.TBL

Each node requires two log files. If you have more than a three to four cluster, addi-
tional symbolic link names must be linked to the files.

For a third node in a cluster, the file ORALINK2.TBL is provided to accommodate 
the node’s log files:

Figure 5–2 ORALINK2.TBL

OPS_log1t1 \Device\Harddiskx\Partitionx
OPS_log2t1 \Device\Harddiskx\Partitionx
OPS_sys01  \Device\Harddiskx\Partitionx
OPS_usr01  \Device\Harddiskx\Partitionx
OPS_rbs01  \Device\Harddiskx\Partitionx
OPS_tmp01  \Device\Harddiskx\Partitionx
OPS_log1t2 \Device\Harddiskx\Partitionx
OPS_log2t2 \Device\Harddiskx\Partitionx
OPS_cntr01 \Device\Harddiskx\Partitionx

symbolic link name

partition number

physical drive number

OPS_log1t3 \Device\Harddiskx\Partitionx
OPS_log2t3 \Device\Harddiskx\Partitionx
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For a fourth node in a cluster, the file ORALINK3.TBL is provided to accommodate 
the node’s log files:

Figure 5–3 ORALINK3.TBL

Below is a description of the symbolic link names:

Symbolic link name... File 
Description

Symbolic link name is 
used in the file 
ORACLE_HOME\OPS\...

OPS_log1t1 recovery log 
file

OPS.SQL

OPS_log2t1 recovery log 
file

OPS.SQL

OPS_sys01 system data file OPS.SQL

OPS_usr01 user data file OPS.SQL

OPS_rbs01 rollback data 
file

OPS.SQL

OPS_tmp01 temporary 
data file

OPS.SQL

OPS_log1t2 first log file for 
thread 1

OPS.SQL

OPS_log2t1 second log file 
for thread 2

OPS.SQL

OPS_cntr01 control file INITSID.ORA, 
INIT_COM.ORA

OPS_log1t4 \Device\Harddiskx\Partitionx
OPS_log2t4 \Device\Harddiskx\Partitionx
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To create symbolic links to the logical partitions:

1. On the primary node, edit the partition and hard disk numbers appropriately in 
the ORALINK1.TBL file located in ORACLE_HOME\OPS to match the disk 
numbers and partitions number you wrote down in “Step 3: Unassign Drive 
Letters” in Chapter 3, “Performing Pre-Installation Tasks”. If the cluster has a 
third and/or fourth node, edit ORALINK2.TBL (for the third node) and 
ORALLINK3.TBL for the fourth node.

You can use a worksheet similar the one below to assist with the process:

For example, the worksheet for the two nodes shown in section “Step 2: Create 
Logical Drives In an Extended Partition” in Chapter 3, “Performing Pre-
Installation Tasks” looks like:

Symbolic Link Node 1 Node 2

OPS_log1t1 Harddiskx Partitionx Harddiskx Partitionx

OPS_log2t1 Harddiskx Partitionx Harddiskx Partitionx

OPS_sys01 Harddiskx Partitionx Harddiskx Partitionx

OPS_usr01 Harddiskx Partitionx Harddiskx Partitionx

OPS_rbs01 Harddiskx Partitionx Harddiskx Partitionx

OPS_tmp01 Harddiskx Partitionx Harddiskx Partitionx

OPS_log1t2 Harddiskx Partitionx Harddiskx Partitionx

OPS_log2t2 Harddiskx Partitionx Harddiskx Partitionx

OPS_cntr01 Harddiskx Partitionx Harddiskx Partitionx

Symbolic Link Node 1 Node 2

OPS_log1t1 Harddisk1 Partition1 Harddisk2 Partition1

OPS_log2t1 Harddisk1 Partition2 Harddisk2 Partition2

OPS_sys01 Harddisk1 Partition3 Harddisk2 Partition3

OPS_usr01 Harddisk1 Partition4 Harddisk2 Partition4

OPS_rbs01 Harddisk1 Partition5 Harddisk2 Partition5

OPS_tmp01 Harddisk1 Partition6 Harddisk2 Partition6

OPS_log1t2 Harddisk2 Partition1 Harddisk3 Partition1
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2. Run the ASCII input file, ORALINK1.TBL through the SETLINKS application 
as shown below:

C:\>CD ORACLE_HOME\OPS
C:\ORACLE_HOME\OPS>SETLINKS /F:ORALINK1.TBL

SETLINKS maps the drives to the symbolic label names:

Oracle Corporation. Copyright (c) 1997. All rights reserved.
Created Link:
Created Link:OPS_log1t1 = Device:\Device\Harddisk1\Partition1
Created Link:OPS_log2t1 = Device:\Device\Harddisk1\Partition2
Created Link:OPS_sys01 = Device:\Device\Harddisk1\Partition3
Created Link:OPS_usr01 = Device:\Device\Harddisk1\Partition4
Created Link:OPS_rbs01 = Device:\Device\Harddisk1\Partition5
Created Link:OPS_tmp01 = Device:\Device\Harddisk1\Partition6
Created Link:OPS_log1t2 = Device:\Device\Harddisk2\Partition1
Created Link:OPS_log2t2 = Device:\Device\Harddisk2\Partition2
Created Link:OPS_cntr01 = Device:\Device\Harddisk3\Partition3
Dos devices updated successfully.

If the cluster has third or fourth node, SETLINKS must be run again with 
OPSLINK2.TBL (for the third node) or OPSLINK3.TBL for the fourth node.

C:\>CD ORACLE_HOME\OPS

OPS_log2t2 Harddisk2 Partition2 Harddisk3 Partition2

OPS_cntr01 Harddisk2 Partition3 Harddisk3 Partition3

Additional Information: See Chapter 3, “Performing Pre-
Installation Tasks”, for further information about the Disk 
Administrator.

WARNING: Do not change the symbolic link names in 
OPSLINK1.TBL. If you do, symbolic link names must be 
modified for the following files located in 
ORACLE_HOME\OPS:

■ OPS.SQL

■ INITSID.ORA

■ INIT_COM.ORA

Symbolic Link Node 1 Node 2
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C:\ORACLE_HOME\OPS>SETLINKS /F:ORALINK2.TBL
C:\ORACLE_HOME\OPS>SETLINKS /F:ORALINK3.TBL

3. Make sure the drives have been mapped with the correct names as shown 
below:

C:\ORACLE_HOME\OPS>SETLINKS /D

SETLINKS shows how the symbolic link names have been mapped:

Oracle Corporation. Copyright (c) 1997. All rights reserved.
OPS_log1t1  = \Device\Harddisk1\Partition1
OPS_log2t1  = \Device\Harddisk1\Partition2
OPS_sys01   = \Device\Harddisk1\Partition2
OPS_usr01   = \Device\Harddisk1\Partition2
OPS_rbs01   = \Device\Harddisk1\Partition5
OPS_tmp01   = \Device\Harddisk1\Partition6
OPS_log1t2  = \Device\Harddisk2\Partition1
OPS_log2t2  = \Device\Harddisk2\Partition2
OPS_cntr01  = \Device\Harddisk2\Partition3
...

4. Repeat Steps 1-3 on the other nodes.

Removing or Ignoring Links
Links can be removed or ignored by changing the contents of the ORALINKx.TBL 
files and running it through SETLINKS again.

Ignore Links
To ignore links:

Insert a ‘#” at the beginning of a line to denote a comment, which is ignored by 
SETLINKS.

Remove Links
To remove an existing symbolic link:

List a symbolic link without a device path in the ORALINKx.TBL file.

For example:

OPS_log1t1 
OPS_log2t1 \Device\Harddisk1\Partition2
OPS_sys01  \Device\Harddisk1\Partition3
OPS_usr01  \Device\Harddisk1\Partition4
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OPS_rbs01  \Device\Harddisk1\Partition5
OPS_tmp01  \Device\Harddisk1\Partition6
OPS_log1t2 \Device\Harddisk2\Partition1
OPS_log2t2 \Device\Harddisk2\Partition2
OPS_cntr01 \Device\Harddisk2\Partition3

This removes the OPS_log1t1 link and creates the other links specified.

Step 2: Configure OSD Layer

To configure the Operating System Dependent (OSD) components:

See your OSD vendor documentation for instructions about configuring the OSD 
components, making sure:

■ the domain name you specify is identical to the database name defined in the 
INIT_COM.ORA file located in ORACLE_HOME\OPS. The database name is 
OPS by default.

■ the machine names you specify are alpha-numeric 

Note: When following the steps below, note that some tasks are 
performed on the primary node only, while other tasks are 
performed on each node.

CAUTION: When configuring domains, two instances cannot 
reside on the same machine and be in the same domain. 
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Step 3: Create Services
After the OSD components have been configured, OracleServiceSID for each 
instance must be created.

To create OracleServiceSID:

1. On each node, go to the ORACLE_HOME\BIN directory:

C:\>CD ORACLE_HOME\BIN
2. On each node, use the CRTSRV batch file to create a service corresponding to 

the instance of the node. 

C:\ORACLE_HOME\BIN>CRTSRV SID

For example, to create OracleServiceOPS1 on the primary node:

C:\ORACLE_HOME\BIN>CRTSRV OPS1

3. Verify OracleServiceSID exists by choosing Services from the Control Panel.

The Services window appears:

4. Some vendors may require changing the password for OracleServiceSID and 
the OracleTNSListener to the Administrator’s password for the machine:

a. Double-click the service. 



Step 3: Create Services

                                                                   Configuring 5-9

The Service dialog box appears:

b. Choose the This Account option button.

c. Choose the “...” button.

The Add User dialog box appears:

d. Choose Administrator from the Names list box and choose Add.

e. Choose OK.

The Service dialog box reappears.
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f. Enter the NT administrator’s password in the Password and Confirm 
Password fields.

g. Choose OK.

The Services window reappears.

h. Choose Close to exit the Services window.

5. Stop OracleServiceSID:

■ From the MS-DOS command line, enter:

C:\>NET STOP OracleServiceSID

■ From the Control Panel’s Services window, select OracleServiceSID, then 
choose Stop.

Step 4: Add the ORACLE_SID Entry to the Registry
The SID for an instance must be set in the registry to allow instance recognition 
when you access a database from a node. When you connect to a database, Oracle 
Parallel Server will be able to resolve the SID name. 

Oracle Parallel Server requires the ORACLE_SID registry value to be manually 
added to the following location:

HKEY_LOCAL_MACHINE\Software\ORACLE

To add the ORACLE_SID registry value:

1. From each node, start the registry in either one of two ways:

■ From the command line, enter:

C:\>REGEDT32

■ Select Run from the Start icon in the Taskbar, enter REGEDT32 in the Open 
field, and choose OK.

Note:  If the SID is not set in the registry, Oracle Parallel Server 
tries to see if the SID is set as an environment variable. If it cannot 
find it, the SID name defaults to ORCL. ORCL is not a valid SID for 
an Oracle Parallel Server. Therefore, you cannot connect with it.
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The Registry Editor window appears:

2. Double-click the SOFTWARE key.

3. Click the ORACLE key.

4. Choose the Add Value option in the Edit menu.

The Add Value dialog box appears:
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5. In the Value Name field, enter ORACLE_SID.

6. In the Data Type box, select REG_SZ.

7. Choose OK.

The String Editor dialog box appears:

8. Enter the SID of the instance for the node you are on.

Registry Editor now adds ORACLE_SID. 

9. Choose Exit from the Registry menu.

The registry exits.

Step 5: Configure the Network
With minimal configuration, the OPSCONF utility creates the following properly 
configured files for all nodes:

■ TNSNAMES.ORA

■ LISTENER_node_hostname.ORA (created for each node in the cluster)

■ TOPOLOGY.OPS

These files are created on the node in ORACLE_HOME\OPS. After creation, you 
need to move the files to their proper configuration file names and to the proper 
machines.

Note: OPSCONF also creates SQL scripts for configuration of 
Performance Manager. 
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Below is a description of the configuration files:

The steps to perform on each node to configure the network include:

■ Step 5a: Stop the Listener.

■ Step 5b: Create the Configuration Files.

■ Step 5c: Start the Listener.

■ Step 5d: Test the Configuration

Step 5a: Stop the Listener
Prior to running OPSCONF, stop the listener. 

To stop the listener:

Stop the OracleTNSListener service:

■ From the MS-DOS command line, enter:

C:\>NET STOP OracleTNSListener

■ From the Control Panel’s Services window, select the OracleTNSListener 
service, then choose Stop.

Configuration File Description

LISTENER_node_hostname
.ORA

Includes service names (or database aliases) and addresses 
of all listeners on a machine, the system IDs (SIDs) for the 
databases they listen for, and various control parameters 
used by the listener. 

TNSNAMES.ORA Includes a list of service names (or databases aliases) of 
network databases mapped to connect descriptors.

TOPOLOGY.OPS Defines the parallel servers and instances in the network.
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Step 5b: Create the Configuration Files
Configuration files can be created with the OPSCONF utility or SQL*Net Easy 
Configuration. In order to use Oracle Enterprise Manager, however, you must use 
OPSCONF. OPSCONF relies on the OSD Performance and Management 
component being set. If this registry entry is not set by your vendor, you must use 
SQL*Net Easy Configuration to create the configuration files, and you will not be 
able to use Oracle Enterprise Manager. 

Below are instructions for both methods:

■ Using OPSCONF

■ Using SQL*Net Easy Configuration

Using OPSCONF
File created with OPSCONF are not compatible with SQL*Net Easy Configuration.

To create the configuration files:

1. On the primary node, go to the ORACLE_HOME\BIN directory:

C:\>CD ORACLE_HOME\BIN

2. Run OPSCONF:

C:\ORACLE_HOME\BIN>OPSCONF

OPSCONF runs in interactive mode, prompting you with configuration 
questions. Bold indicates user input:

1. Enter the name of the Oracle Parallel Server database.

database_name
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The database name is defined in the INIT_COM.ORA file in 
ORACLE_HOME\OPS. The database name is defaulted to OPS.

2. Enter the port number of the listener (Default=1526).

port_number

Press [Enter] to accept the default value.

3. Enter the port number of the Oracleagent (Default=1748).

Press [Enter] to accept the default value unless you have changed the port 
number.

All the configuration files listed above are created in ORACLE_HOME\OPS.

3. Move each LISTENER_node_hostname.ORA file to the 
ORACLE_HOME\NETWORK\ADMIN directory to the appropriate node, 
renaming it to LISTENER.ORA.

4. Copy each TNSNAMES.ORA file to the 
ORACLE_HOME\NETWORK\ADMIN directory on each of the nodes, all 
client machines, and the Oracle Enterprise Manager console.

5. Move TOPOLOGY.OPS to the ORACLE_HOME\NETWORK\ADMIN 
directory on the Oracle Enterprise Manager console workstation, renaming it to 
TOPOLOGY.ORA.

Or, merge it with your existing TOPOLOGY.ORA. 

6.  Continue to “Step 5c: Start the Listener”.

ERROR MESSAGE: If you receive the following error message, 
the Performance and Management component is not supported by 
your vendor. You must use SQL*Net Easy Configuration to create 
the configuration files. 

Failed to load path\pm.dll
ERROR: Unable to access configuratin 
information.

Additional Information: See “Using SQL*Net Easy Configuration”.

Additional Information: See Chapter 4, “Configuration”, in the 
Oracle Network Products Getting Started for Windows Platforms.
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Using SQL*Net Easy Configuration
SQL*Net Easy Configuration should only be used if your vendor does not support 
the Performance and Management component. Without the Performance and 
Management component, you cannot use Oracle Enterprise Manager. Files created 
with SQL*Net Easy Configuration are not compatible with files created with 
OPSCONF.

To create the configuration files:

1. On the primary node, choose Start>Programs>Oracle for Windows 
NT>SQL*Net Easy Configuration:

The SQL*Net Easy Configuration window appears:

2. Select Add Database Alias and choose OK. 

The Choose Database Alias dialog box appears:

3. Enter a database alias name to identify the database to access and choose OK. 
The alias can be any name you choose.
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The Choose Protocol dialog box appears if more than one Oracle Protocol 
Adapter resides in your ORACLE_HOME directory. Go to Step 4.

If you installed only one protocol adapter, the dialog box appropriate for your 
protocol adapter appears, as shown in Step 4. Go to Step 5.

4. Select TCP/IP and choose OK.

The Choose TCP/IP Host Name and Database Instance dialog box appears.

5. Enter the name of the node in the TCP/IP Host Name field and the SID (OPS1) 
in the Database Instance field:

6. Choose OK.

The Confirm Adding Database Alias dialog box appears.

7. Choose Yes to confirm.

The SQL*Net Easy Configuration window re-appears.

8. Select Exit SQL*Net Easy Configuration and choose OK.

The configuration files are created in the ORANT\NETWORK\ADMIN 
directory. 

9. Modify the line (SID-NAME=ORCL) in the LISTENER.ORA file with the name 
of the instance SID. 
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For example, to modify the file for the primary node’s OPS1 instance: 

SID_LIST_listener_name=

   (SID_LIST =

      (SID_DESC =

         (SID_NAME = OPS1)

10. Repeat Steps 1-9 for the other nodes in the cluster.

Step 5c: Start the Listener
To start the listener:

Start the OracleTNSListener service:

■ From the MS-DOS command line, enter:

C:\>NET START OracleTNSListener

■ From the Control Panel’s Services window, select the OracleTNSListener 
service, then choose Start.

Step 5d: Test the Configuration
To ensure the files are configured correctly:

1. On any node or client machine, start Server Manager. Enter:

C:\>SVRMGR23

2. Connect to an instance:

SVRMGR>CONNECT INTERNAL/ORACLE@OPS1
SVRMGR>CONNECT INTERNAL/ORACLE@OPS2

If there is an error in connecting, you must troubleshoot your installation. 
Typically, there is a problem with the IP address, host name, or SID.
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Step 6: Create an Oracle Parallel Server Database

Creating an Oracle Parallel Server database involves generating:

■ database files and rollback segments

■ tablespaces

■ SYSTEM tables

To create the Oracle Parallel Server database:

1. Ensure the OaclePGMSService service is running on the primary node (it should 
have already been started at boot time):

a. From the Control Panel window, double-click Services. 

b. Look for OaclePGMSService in the Services window. A blank in Status 
column indicates that the service is not running. If the service is already 
running, close the dialog box and go to Step 3. If the service is not running, 
go to Step c.

c. Start the OaclePGMSService service:

• From the MS-DOS command line, enter:

C:\>NET START OaclePGMSService

• From the Control Panel’s Services window, select OaclePGMSService, 
then choose Start.

2. Start the OracleServiceOPS1 service:

■ From the MS-DOS command line, enter:

C:\>NET START OracleServiceOPS1

■ From the Control Panel’s Services window, select OracleServiceOPS1 
service, then choose Start.

Starting this service starts the DLM for the primary node. 

CAUTION: The instructions below assume the domain you 
specified during the OSD configuration is identical to the 
database name defined in the INIT_COM.ORA file.
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3. Ensure there is a Reconfiguration complete message in the 
C:\DLM\SID\LOGS\DLM.LOG file, signifying the cluster was started 
without errors. 

New entries to the DLM.LOG file are entered at the top of the file. 

############################################################################
BEGIN LOG - Thu May 22 16:13:26 1997
...
16:13:32-312-00139- Reconfiguration started: Thu May 22 16:13:32 1997
16:13:32-312-00139- List of nodes: 0,
16:13:32-390-00139- Reconfiguration complete: Thu May 22 16:13:32 1997

If you did not receive this message, check the 
C:\DLM\SID\LOGS\DLMSTART.LOG file.

4. Connect to the instance and run the OPSALL.SQL script to create the database:

C:\>CD ORACLE_HOME\OPS
C:\ORACLE_HOME\OPS>SVRMGR23
SVRMGR>@OPSALL.SQL

The OPSALL.SQL script:

■ Calls the OPS.SQL script to create the Oracle Parallel Server database files, 
rollback segments, and tablespaces

■ Builds a system data dictionary

■ Creates users

■ Creates views

■ Creates redo log files for each instance

■ Shuts down the database

5. Stop OracleServiceOPS1:

■ From the MS-DOS command line, enter:

C:\>NET STOP OracleServiceOPS1

Note: The OPS.SQL script may be modified to better suit your 
database needs.
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■ From the Control Panel’s Services window, select OracleServiceOPS1 
service, then choose Stop.

Step 7: Start the Database in Parallel Mode
To start the Oracle Parallel Server database in parallel mode:

1. On each node, delete the C:\DLM\SID\LOGS\DLM.LOG file.

This file is re-created with new Oracle Parallel Server messages.

2. Ensure the OaclePGMSService service is running on each node (it should have 
already been started at boot time):

a. From the Control Panel window, double-click Services. 

b. Look for OaclePGMSService in the Services window. A blank in Status 
column indicates that the service is not running. If the service is already 
running, close the dialog box and go to Step 3. If the service is not running, 
go to Step c.

c. Start OaclePGMSService:

• From the MS-DOS command line, enter:

C:\>NET START OaclePGMSService

• From the Control Panel’s Services window, select OaclePGMSService 
service, then choose Start.

3. Start OracleServiceSID instance on each node. 

■ From the MS-DOS command line, enter:

C:\>NET START OracleServiceOPS1

■ From the Control Panel’s Services window, select OracleServiceSID, then 
choose Start.

Starting these services starts the DLM for each of the nodes.

Note: When following the steps below, note that some tasks are 
performed on the primary node only, while other tasks are 
performed on each node.
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4. On each node, ensure there is a Reconfiguration complete message in the 
C:\DLM\SID\LOGS\DLM.LOG file for the correct number of nodes, 
signifying the cluster was started without errors. 

Below is a sample of the log file, indicating successful startup for two nodes:

############################################################################
BEGIN LOG - Thu May 22 16:13:26 1997
16:13:32-312-00139- Reconfiguration started: Thu May 22 16:13:32 1997
16:13:39-296-00139- List of nodes: 0,1
...
16:13:47-468-00139- Reconfiguration complete: Thu May 22 16:13:47 1997

If you did not receive this message, check the 
C:\DLM\SID\LOGS\DLMSTART.LOG file for errors.

5. On the primary node, start the database:

C:\>SVRMGR23
SVRMGR>CONNECT INTERNAL/ORACLE
SVRMGR>STARTUP PFILE=C:%ORACLE_HOME%\OPS\INITOPS1.ORA PARALLEL

The first instance to start up in shared mode determines the values of the 
global constant parameters for the other instances. The control file records the 
values of the GC_* parameters when the first instance starts up.

When another instance attempts to start up in shared mode, the Oracle Server 
compares the values of the global constant parameters in its parameter file with 
those already in use and issues a message if any values are incompatible. The 
instance cannot mount the database unless it has the correct values for its 
global constant parameters.

6. On the remaining nodes, start the database:

C:\>SVRMGR23
SVRMGR>CONNECT INTERNAL/ORACLE
SVRMGR2STARTUP PFILE=C: %ORACLE_HOME%\OPS\INITSID.ORA PARALLEL

Note: INITSID.ORA defines the rollback segments for each node 
and points to the INIT_COM.ORA file for Oracle Parallel Server 
parameters.

Additional Information: See Chapter 9, “Backing Up and 
Recovering an Oracle Parallel Server Database”, for further 
information about the initialization files.
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Step 8: Verify Instances Are Running
To verify instances are running:

1. On any node, enter the following:

C:\>SVRMGR23
SVRMGR>CONNECT INTERNAL/ORACLE
SVRMGR>SELECT * FROM V$ACTIVE_INSTANCES;

The following output is returned:

INST_NUMBRE  INST_NAME
-----------  ---------
           1 node1:ops1
           2 node2:ops2
           3 node3:ops3
. . .

2. On all the nodes, connect as SCOTT/TIGER, view the EMP table.

C:\>SVRMGR23
SVRMGR>CONNECT SCOTT/TIGER
SVRMGR>SELECT * FROM EMP;

The employee table displays:

    EMPNO ENAME      JOB             MGR HIREDATE        SAL      COMM    DEPTNO
--------- ---------- --------- --------- --------- --------- --------- ---------
     7369 SMITH      CLERK          7902 17-DEC-80       800                  20
     7499 ALLEN      SALESMAN       7698 20-FEB-81      1600       300        30
     7521 WARD       SALESMAN       7698 22-FEB-81      1250       500        30
     7566 JONES      MANAGER        7839 02-APR-81      2975                  20
     7654 MARTIN     SALESMAN       7698 28-SEP-81      1250      1400        30
     7698 BLAKE      MANAGER        7839 01-MAY-81      2850                  30
     7782 CLARK      MANAGER        7839 09-JUN-81      2450                  10
     7788 SCOTT      ANALYST        7566 19-APR-87      3000                  20
     7839 KING       PRESIDENT           17-NOV-81      5000                  10
     7844 TURNER     SALESMAN       7698 08-SEP-81      1500         0        30
     7876 ADAMS      CLERK          7788 23-MAY-87      1100                  20
     7900 JAMES      CLERK          7698 03-DEC-81       950                  30
     7902 FORD       ANALYST        7566 03-DEC-81      3000                  20
     7934 MILLER     CLERK          7782 23-JAN-82      1300                  10
14 rows selected.

CAUTION: If another node is reconfigured after this table has 
been accessed and this statement is issued again, only the last 
node whose database was started displays.
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3. On the one node, connect increase MILLER’s salary by $1000 and commit the 
change:

SVRMGR>UPDATE EMP
SET SAL = SAL + 1000
WHERE ENAME = ‘MILLER’;
SVRMGR>COMMIT;

4. On the other nodes, select the EMP table again:

SVRMGR>SELECT * FROM EMP;

MILLER’s salary should now be $2,300, indicating the all the instances can see 
the database.

5. Continue to Chapter 6, “Installing and Configuring Oracle Enterprise 
Manager” if you want to configure Oracle Enterprise Manager.
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6
Installing and Configuring Oracle Enterprise

Manager

This chapter describes how to configure Oracle Enterprise Manager and the 
Performance Manager.

Specific topics covered in this chapter are:

■ Overview of Oracle Enterprise Manager

■ Step 1: Install Oracle Enterprise Manager

■ Step 2: Configure Oracle Enterprise Manager

■ Step 3: Configure Oracle Performance Manager

WARNING: If your vendor does not support the OSD 
Performance and Management component, and you were not 
able to create configuration files with OPSCONF (as described in 
“Using OPSCONF” in Chapter 5, “Configuring”), you will not 
able to use Oracle Enterprise Manager. 

The Performance and Management component does not affect 
the configuration of the Performance Pack Performance Manager. 
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Overview of Oracle Enterprise Manager

Oracle Enterprise Manager  Oracle Enterprise Manager works with the Oracle 
Intelligent Agent (installed on the Oracle7 database server) to perform database 
administration from a single console. Oracle Enterprise Manager is installed on a 
console workstation, a Windows NT or Windows 95 client. 

Oracle Intelligent Agent  The Oracle Intelligent Agent is installed on the Oracle7 
database server to be managed. The Oracle Intelligent Agent is responsible for 
managing and completing tasks requested from the Oracle Enterprise Manager 
Console workstation. Once installed, the Oracle Intelligent Agent:

■ listens for and responds to job requests initiated by the Oracle Enterprise 
Manager Console workstation 

■ schedules job requests (requests can include detecting and correcting abnormal 
conditions, performing standard database administration procedures, and 
monitoring events)

■ executes the job request

Attention: Oracle Enterprise Manager uses a repository database 
to store its information. This repository database is an Oracle7 
database installed on either:

■ An Oracle Enterprise Manager Console if it is a Windows NT 
machine 

■ A separate Windows NT machine to which a Windows 95 or 
Windows NT Oracle Enterprise Manager Console can connect

The Oracle7 database to be managed by the Oracle Enterprise 
Manager Console must not also act as the Oracle7 repository 
database. If it does, you will not be able to perform many database 
administration tasks, such as starting or shutting down the 
database. The repository database must be on a separate machine 
whose sole responsibility is to act as the Oracle Enterprise 
Manager’s storage resource.
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Step 1: Install Oracle Enterprise Manager
Oracle Enterprise Manager installs on a console workstation, a Windows NT or 
Windows 95 client. 

Oracle Enterprise Manager uses an Oracle7 repository database to store its 
information. This Oracle7 database installs on the console if it is a Windows NT 
console, or on another Windows NT machine where the Windows 95 console can 
connect. 

In any case, no server node in the cluster should also act as the repository database. 
This causes unreliable information if the server should go down. The repository 
database should be on a machine whose sole responsibility is to act as the Oracle 
Enterprise Manager’s storage resource.

Installing Oracle Enterprise Manager includes:

■ Step 1a: Install Repository Database on Windows NT

■ Step 1b: Install Oracle Enterprise Manager on Console Workstation.

■ Step 1c: Install OPSM Client on Console Workstation

Step 1a: Install Repository Database on Windows NT
The repository database is an Oracle7 database installed on the console if it is a 
Windows NT machine, or on another Windows NT machine where the Windows 
95 or Windows NT console can connect.

To install the repository database:

Install Oracle7 Server on a Windows NT Server by following the instructions in the 
installation CD-ROM insert.
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Step 1b: Install Oracle Enterprise Manager on Console Workstation
Oracle Enterprise Manager is installed on a console workstation, a Windows NT or 
Windows 95 client which connects to the Oracle7 repository database.

To install the Oracle Enterprise Manager:

1. Install Oracle Enterprise Manager from the Software Asset Manager window 
after choosing the Custom Installation option.

2. Install the Oracle Enterprise Manager Performance Pack to use the 
Performance Manager. Performance Pack is on another CD, requiring a 
separate license.

Step 1c: Install OPSM Client on Console Workstation

To install Oracle Parallel Server Manager Client:

Install Oracle Parallel Server Manager Client from the Software Asset Manager 
window after choosing the Custom Installation option. 

Additional Information: See the installation CD-ROM insert for 
complete installation instructions.

CAUTION: These instructions assume Oracle Enterprise 
Manager is already installed on a Windows NT or Windows 95 
console workstation. Do not install Oracle Enterprise Manager 
after installing OPSM Client. If you do, OPSM will not work.

Additional Information: See the installation CD-ROM insert to 
install Oracle Enterprise Manager.

Additional Information: See the installation CD-ROM insert for 
complete installation instructions.
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Step 2: Configure Oracle Enterprise Manager
Perform the following configuration tasks after installing the Oracle Enterprise 
Manager on a client Windows NT or Windows 95 console workstation and the 
Oracle Intelligent Agent on each node in the cluster:

■ Step 2a: Start Oracle Services

■ Step 2b: Create a Repository User Account

■ Step 2c: Create a Windows NT User Account

■ Step 2d: Access Oracle Enterprise Manager and Create the Repository

Note: These instructions assume Oracle Enterprise Manager and 
OPSM Client are already installed on a Windows NT or Windows 
95 console workstation. See the installation CD-ROM insert to 
install Oracle Enterprise Manager and see “Step 1b: Install Oracle 
Enterprise Manager on Console Workstation” to install OPSM 
Client.
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Step 2a: Start Oracle Services
To start the Oracle services:

Ensure the OracleServiceSID, OracleTNSListener, OracleAgent and PGMS services 
are running on each node:

a. From the Control Panel window, double-click Services. 

b. Look for the service in the Services window. A blank in Status column 
indicates that a service is not running. If all the service are already running, 
close the dialog box and go to Step 3. If a service is not running, go to Step 
c.

c. Start the service:

• From the MS-DOS command line, enter:

C:\>NET START SERVICE

• From the Control Panel’s Services window, select a service, then choose 
Start.

Step 2b: Create a Repository User Account
You need to have a user account with DBA (database administrator) privileges set 
up on the Oracle7 repository database. This repository database can be on:

■ The same Windows NT machine on which the Oracle Enterprise Manager 
Console is installed.

■ A separate Windows NT machine to which the Oracle Enterprise Manager 
Console can connect.

Oracle Enterprise Manager places its repository in the default tablespace of the user 
account to which you are connected when creating the repository. Because of this, 
Oracle Corporation recommends that you create a new user account so that the 
repository can be created in its own tablespace. It is also recommended that you 
create a new tablespace and the newly-created user be customized to use this 
tablespace as its default tablespace. 

To create a repository user account on the Oracle7 repository database:

1. Start Server Manager and connect to the Oracle7 repository database:

C:\> SVRMGR23
SVRMGR> CONNECT SYSTEM/MANAGER

2. Create a special tablespace for the Oracle Enterprise Manager repository: 
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SVRMGR> CREATE TABLESPACE REPOSIT_TABLESPACE DATAFILE 
’ORACLE_HHOME\path\DATAFILE’ SIZE XM;

where path\DATAFILE is the path to the datafile and X is the tablespace size in 
megabytes; 20 MB is a good starting place.

3. Create a user account where the user’s default tablespace is the newly-created 
tablespace: 

SVRMGR> CREATE USER USERNAME IDENTIFIED BY PASSWORD
2> DEFAULT TABLESPACE REPOSIT_TABLESPACE;

4. Grant the SYSTEM privileges to this user account: 

SVRMGR> GRANT DBA TO USERNAME IDENTIFIED BY PASSWORD;

5. When done, enter:

SVRMGR> EXIT

Exiting Server Manager closes the database connection.

6. Follow Steps 1-5 for additional repository user accounts.
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Step 2c: Create a Windows NT User Account
After a repository user account is created, an NT user account with the same user 
name as the repository user account must be created on the Oracle7 database that 
will be managed (that is, the machine on which you performed “Step 2a: Start 
Oracle Services”).

To create a user account on each node of the cluster

1. Choose Start>Programs>Administrative Tools>User Manager.

The User Manager window appears:

2. Choose New User from the User menu.
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The New User dialog box appears:

3. Enter the appropriate information in the dialog box:

a. Enter a user name that is the same as the one you entered in section “Step 
2b: Create a Repository User Account” in the Username field.

b. Enter the same password you entered in section “Step 2b: Create a 
Repository User Account” in both the Password and Confirm Password 
fields.

c. Make sure the User Must Change Password at Next Logon check box is not 
checked and Password Never Expires check box is checked.

d. Make the user a member of the Administrator’s group by choosing Groups.

The Group Memberships dialog box appears:

e. Select Administrators from the Not member of list box and choose <- Add.
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Administrators is added to the Member of list box.

f. Click OK to close the Group Memberships dialog box and return to the New 
User dialog box.

4. Click OK in the New User dialog box.

The user is added and the User Manager window re-appears.

5. Select the newly-created user and choose User Rights from the Policies menu.

The User Rights Policy dialog box appears:

6. Click the Show Advanced User Rights check box and select Log on as a batch job 
from the Right drop-down list box.

7. Select Users from the Grant To list box.

If Users does not exist, create it:

a. Click Add.
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The Add Users and Groups dialog box appears:

b. Select the names of the local host machine from the List Names From drop-
down list box.

c. Select Users from the Names list box and click Add.

d. Click OK.

Users appears in the Grant To list box.

8. Click OK in the User Rights Policy dialog box.

The User Manager window re-appears.

9. Choose Exit from the User menu.

10. Repeat Steps 1-9 for any other repository user accounts you created.
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Step 2d: Access Oracle Enterprise Manager and Create the Repository

Before you can use Oracle Enterprise Manager, you need a repository on the 
console workstation where Oracle Enterprise Manager will run. The repository is a 
set of base tables in a database that contains status and environment information 
for your managed databases. A separate repository must be created for each user 
wanting to use Oracle Enterprise Manager. 

The Oracle Enterprise Manager console workstation must also discover network 
services, such as databases, listeners, and nodes, to populate the Oracle Enterprise 
Manager Navigator tree. In addition to discovery, the Oracle Enterprise Manager 
must also be able to manage these services for the Job Scheduling and Event 
Management systems. This can be achieved with the Discovery Wizard.

When the agent starts up and is explicitly requested by the Oracle Enterprise 
Manager with the Navigator Discovery feature, the agent passes information from 
the Oracle Enterprise Manager console to populate the Navigator tree.

Note: If Oracle Enterprise Manager is installed on a Windows 95 
or Windows NT client console, ensure the client machine is 
configured with a TNSNAMES.ORA file so it can connect to the 
Oracle7 repository database. See “Step 5: Configure the Network” 
in Chapter 5, “Configuring”.
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To create a repository on the console workstation:

1. On the console workstation, select Start>Programs>Oracle Enterprise 
Manager>Enterprise Manager.

The Oracle Enterprise Manager repository Login Information dialog box appears:

2. Enter the following appropriate information and choose OK:

■ Repository user name and password you created in “Step 2b: Create a 
Repository User Account” in Username

■ SQL*Net service name (or database alias) of the repository database; only 
necessary to enter service name if you are connecting from a client console 
machine connecting to the repository database on a different machine

The Oracle Repository Manager window appears, prompting you to build the 
repository:

3. Click OK. 

The repository is built.
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The Discover New Services Wizard appears:

4. Follow the wizard to discover services.

Services are discovered when you see the dialog box below with a status of 
Discovered:

5. Click Close.
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After the repository is built, the Oracle Enterprise Manager console appears with 
access to the Oracle Parallel Servers in the Navigator tree:

Additional Information: See the Oracle Parallel Server Support for 
the Oracle Enterprise Manager Console and the Oracle Enterprise 
Manager Administrator’s Guide for further information about 
managing Oracle Parallel Servers and parallel server instances 
from Oracle Enterprise Manager.
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Step 3: Configure Oracle Performance Manager

The Oracle Enterprise Manager’s Performance Manager allows you to choose from 
a variety of tabular and graphic performance statistics for parallel servers. The 
statistics represent the aggregate performance for all instances running on a parallel 
server. The statistics are display in individual charts and include information on 
data block pings, lock activity, file I/O, and session and user information. 

Requirements

Performance Manager requires the following:

■ Oracle Enterprise Manager Performance Pack must be installed.

■ Each instance must have a TNS service name defined for it, which is used in 
defining the database links for the instances. The TNSNAMES.ORA containing 
these service names must be installed on each node. 

■ The SIDs of the instances in the parallel server must be different. Otherwise it 
will not be possible to distinguish among them in the Performance Manager 
displays.

Note: Performance Manager is not dependent on Oracle 
Enterprise Manager or your vendor’s OSD Performance and 
Management component.

Note: The following requirements are met if you followed all the 
steps in Chapter 5, “Configuring”.

Note: The Enterprise Manager Intelligent Agent is not required 
by the Performance Manager, as its functions are performed using 
a database connection to the parallel server.
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Configuration
Configuring the Performance Manager involves running the OPS_MON.SQL to 
run the following SQL scripts:

If you used OPSCONF to generate the configuration files in section “Using 
OPSCONF” in Chapter 5, “Configuring”, the OPS_DBL.SQL script will already 
exist in the ORACLE_HOME\OPS directory. If OPSCONF was not used, 
OPS.DBL.SQL must be created hand prior to running OPS_MON.SQL. The other 
scripts are created during installation.

To configure the Performance Manager:

1. Check to see if ORACLE_HOME\OPS\OPS_DBL.SQL exists on the node where 
OPSCONF was run (if at all).

If it does not exist, go to Step 2. If it does exist, go to Step 3.

2. Create the OPS_DBL.SQL script by following the format below:

The format of ORACLE_HOME\OPS\OPS_DBL.SQL script file is as follows for 
each instance's entry:

■ drop public database link;

■ create public database link <db_name>@<node_name>_<SID> using 
'<service_name>', where:

Script Description

OPS_PACK.SQL Contains a set of PL/SQL procedures that are executed by 
Performance Manager to aggregate results from all instances of 
the parallel server.

OPS_CTAB.SQL Contains a set of tables used to store the aggregated results.

OPS_DBL.SQL Contains database links for each instance of the parallel server.

db_name database name from V$DATABASE

node_name host name of the node on which the instance runs

SID instance name

service_name SQL*Net connect string for the instance
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Below is an example OPS_DBL.SQL script for a database named “OPS” with 
four instances:

■ ops1 running on node opshost13

■ ops2 running on node opshost14

■ ops3 running on node opshost15

■ ops4 running on node opshost16

  drop public database link ops@opshost13_ops1
  /
  create public database link ops@opshost13_ops1 using ’ops1’
  /
  drop public database link ops@opshost14_ops2
  /
  create public database link ops@opshost14_ops2 using ’ops2’
  /
  drop public database link ops@opshost15_ops3
  /
  create public database link ops@opshost15_ops3 using ’ops3’
  /
  drop public database link ops@opshost16_ops4
  /
  create public database link ops@opshost16_ops4 using ’ops4’
  /

3. Enter the following at the MS-DOS command line from any node:

C:\>CD ORACLE_HOME\OPS
C:\ORACLE_HOME\OPS>SVRMGR23
SVRMGR>@OPS_MON.SQL

OPS_MON.SQL executes the following scripts:

■ OPS_PACK.SQL

■ OPS_CTAB.SQL

■ OPS_DBL.SQL

4. Ensure the database links have been created using the proper database names:

SELECT NAME FROM V$DATABASE;

If you configured the Oracle Parallel Server with the default scripts, OPS (the 
default name of the database) is returned to the screen.
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5. Increase the OPEN_LINKS and DISTRIBUTED_TRANSACTAIONS parameters 
in the INIT_COM.ORA file by the number of instances in the parallel server: 

Once the scripts have been executed, Enterprise Manager Performance 
Manager can be invoked against any instance of the parallel server. 
Performance Manager will execute a PL/SQL procedure on this instance to 
query for performance data from all instances of the parallel server via 
database links, aggregating the results into a set of database tables, which are 
then displayed in graphical form by Performance Manager.

OPEN_LINKS Specifies the maximum number of concurrent open 
connections to remote databases in one session. The 
default is set to 4.

DISTRIBUTED_TRANS
ACTIONS

Specifies the maximum number of distributed transactions 
in which this database can concurrently participate. The 
default is set to 16.

Note: By default these parameters are not stored in the 
INIT_COM.ORA file. To increase the value of these parameters, 
you must add them to the INIT_COM.ORA file.
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Accessing Performance Manager

To start the Performance Manager:

1. Choose Start>Programs>Oracle Enterprise Manager>Enterprise Manager.

The Oracle Enterprise Manager Repository Login Information dialog box appears:

2. Enter the following information and choose OK:

■ Repository user name

■ Password for the user name

■ Service name (or database alias) of the repository database

You are prompted to build the repository.

3. Select a database instance in the Oracle Enterprise Manager navigator tree with 
which a connection will be established. 

4. Start the Performance Manager by:

■ Clicking on the Performance Manager application icon from the 
Performance Pack launch palette.

■ Selecting Performance Pack, and then Performance Manager From the 
Tools menu.

Note: Performance Manager requires at least two instances in the 
Oracle Parallel Server be up and running.
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The Oracle Performance Manager window appears:

5. From the Display menu, choose Parallel Server>option to access the charts.

Using Performance Manager
After the repository is built, the Oracle Enterprise Manager appears with access 
to the Oracle Parallel Servers in the Navigator tree:

ATTENTION: If only one instance of the Oracle Parallel Server is 
running, parallel server options will not be available. At lease two 
instances of the Oracle Parallel Server must be running in order to 
use the Performance Manager’s options.

Additional Information: See Chapter 3, “Monitoring Oracle 
Parallel Server Performance,” in the Oracle Parallel Server Support 
for the Oracle Enterprise Manager Console for further information 
about using the Performance Manager.
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7
Administering Multiple Instances

This chapter describes how instances are managed through initialization files and 
Oracle Parallel Server Manager.

Specific topics covered in this chapter are:

■ Understanding the Initialization Files

■ Setting Initialization Parameters for the Oracle Parallel Server

■ Starting and Stopping Instances with Oracle Parallel Server Manager
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Understanding the Initialization Files 
Each node consists of an initialization parameter file named INITSID.ORA with 
parameters unique for an instance and an initialization parameter file named 
INIT_COM.ORA with common parameters shared from node-to-node. An 
initialization parameter file is an ASCII text file containing a list of parameters. 

Purpose of INITSID.ORA
The instance INITSID.ORA initialization parameter files point to INIT_COM.ORA 
file for common parameters and define the:

■ unique instance number

■ thread number for instance

■ private rollback segments for an instance

Instance 
OPS1

INITOPS1.ORA

Instance 
OPS2

INITOPS2.ORA

primary node second node

Instance 
OPS3

INITOPS3.ORA

third node
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Purpose of INIT_COM.ORA
INIT_COM.ORA is called by the individual parameter files through the IFILE 
parameter. 

In a parallel server, some initialization parameters must have the same values for 
every instance, whether individual or common parameter files are used. By 
referencing the common parameter file using the IFILE parameter within the 
individual parameter files, instances that have individual parameter files can use 
the correct parameter values for those that must be identical. This also allows 
individual parameter files with different values.

Instance 
OPS1

INITOPS1.ORA

Instance 
OPS2

INITOPS2.ORA

INIT_COM.ORA

primary node second node

INIT_COM.ORA
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Figure 7–1 shows the contents of INITOPS1.ORA:

Figure 7–1 INITOPS1.ORA

instance_number=1
thread=1
rollback_segments=(RB1, RB2, RB3, RB4, RB5, RB6, RB7, RB8)
ifile=ORACLE_HOME\database\init_com.ora

Figure 7–2 shows the contents of INITOPS2.ORA:

Figure 7–2 INITOPS2.ORA

instance_number=2
thread=2
rollback_segments=(RB9, RB10, RB11, RB12, RB13, RB14, RB15, RB16)
ifile=ORACLE_HOME\database\init_com.ora

Note: During the configuration process, these initialization files 
are automatically created.
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Figure 7–3 shows a sample INIT_COM.ORA file:

Figure 7–3 INIT_COM.ORA

db_name = ops
db_files = 20
control_files = \\.\PD_cntr01
compatible = 7.3.0.0.0

gc_db_locks=1000
gc_files_to_locks=”1=100:2-8=100EACH”
gc_rollback_segments=34

db_file_multiblock_read_count =  8
db_block_buffers =  200                          
shared_pool_size =  6500000                          
log_checkpoint_interval = 10000
processes =  50                                         
dml_locks =  100                                         
log_buffer =  8192                                       
sequence_cache_entries =  10               
sequence_cache_hash_buckets =  10    
max_dump_file_size = 10240      
background_dump_dest=%RDBMS73%\trace
user_dump_dest=%RDBMS73%\trace
db_block_size = 2048
snapshot_refresh_processes = 1
remote_login_passwordfile = shared
text_enable = true

These parameters are described next.
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Setting Initialization Parameters for the Oracle Parallel 
Server

This section describes the following:

■ GC_* Global Constant Parameters

■ Parameter Notes for Multiple Instances

■ Identical Parameters on Each Instance

■ Parameter Descriptions

■ Location of Initialization Files

■ Editing Initialization Files

GC_* Global Constant Parameters 
Initialization parameters with the prefix GC (Global Constant) are relevant only for 
an Oracle Parallel Server. These parameters are specified in the INIT_COM.ORA 
file. 

Global constant parameter settings determine the size of the collection of global 
locks that protect the database buffers on all instances. The settings you choose 
affect the use of certain operating system resources. 

Of the instances (OPS1, OPS2, and so on), the first instance to start up in shared 
mode determines the values of the global constant parameters for the other 
instances. The control file records the values of the GC_* parameters when the first 
instance starts up.

When another instance attempts to start up in shared mode, the Oracle Server 
compares the values of the global constant parameters in its parameter file with 
those already in use and issues a message if any values are incompatible. The 
instance cannot mount the database unless it has the correct values for its global 
constant parameters.
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The global constant parameters for an Oracle Parallel Server are:

Parameter Description

_ENABLE_DBA_LOCKING Specifies whether PCM fine-grain locks are enabled or 
disabled. 

Default is set to FALSE.

GC_DB_LOCKS Number of locks covering the database blocks (data 
segments) cached in multiple System Global Areas 
(SGAs).

The value must be equal to or larger than the number 
of locks in GC_FILES_TO_LOCKS.

GB_FILES_TO_LOCKS Controls the mapping of blocks from data files to sets 
of DLM locks.

GC_FREELIST_GROUPS Determines the number of locks to specify for free list 
group blocks.

GB_LCK_PROCS Specifies the number of LCK background processes 
for one instance.

GC_RELEASABLE_LOCKS Sets the maximum number of releasable locks in an 
instance.

Sets default mode for locking to use fine grain locking, 
instead of hashed locks.

Each instance can have a different number of 
releasable locks.

GC_ROLLBACK_LOCKS Sets the number of locks available for concurrent 
modifications to rollback segment blocks per rollback 
segment.

GC_ROLLBACK_SEGMENTS Specifies the maximum number of locks to allocate for 
all rollback segments blocks per rollback segment.

The value must be set to the number of rollback 
segment in the database.

GC_SAVE_ROLLBACK_LOCKS Reserves locks for deferred rollback segments that 
contain rollback entries for transactions in tablespaces 
that were taken offline.

GC_SEGMENTS Specifies the maximum number of locks to allocate for 
all segment headers in the database.
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Parameter Notes for Multiple Instances
Multiple instance issues concerning initialization parameters in the 
INIT_COM.ORA file are summarized in the following table.

GC_TABLESPACES Specifies the maximum number of tablespaces that 
can be brought offline concurrently.

Note: Fine-grain locking is enabled by setting a GC_ parameter to 
0 and setting the _ENABLE_DBA_LOCKING parameter to TRUE. 
For example:

■ GC_DB_LOCKS =0 enables fine-grain locking for data blocks.

■ GC_ROLLBACK_LOCKS=0 enables fine-grain locking for 
undo blocks.

Parameter Parallel Server Notes

CHECKPOINT_PROCESS In Oracle Parallel Server, your database can have 
more datafiles. To speed up checkpoints, enable the 
CHECKPOINT_PROCESS parameter. 

DELAYED_LOGGING_BLOCK_
CLEANOUTS 

If set to TRUE, this parameter can potentially reduce 
pinging between instances. 

DML_LOCKS This parameter must be identical on all instances only 
if set to zero.

INSTANCE_NUMBER If specified, this parameter must have unique values 
for different instances. 

LOG_ARCHIVE_FORMAT You must include the thread number. 

MAX_COMMIT_PROPAGATION_
DELAY

If you want commits to be seen immediately on 
remote instances, you may need to change the value 
of this parameter.

NLS_* parameters This parameter can have different values for different 
instances. 

Parameter Description
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Identical Parameters on Each Instance
Certain initialization parameters are critical at database creation or affect certain 
database operations. These parameters must have the same value for every 
instance in an Oracle Parallel Server specified in each INIT_COM.ORA file for each 
instance. For example, the values of DB_BLOCK_SIZE and CONTROL_FILES must 
be identical for every instance. Other parameters can have different values for 
different instances; for example, INIT_SQL_FILES can have any value because it is 
ignored except when the database is created.

The following initialization parameters must have identical values for every 
instance in a parallel server:

PROCESSES This parameter must have a value large enough to 
allow for all background processes and all user 
processes in an instance. Some operating systems can 
have additional DBWR processes. Defaults for the 
SESSIONS and TRANSACTIONS parameters are 
derived directly or indirectly from the value of the 
PROCESSES parameter. If you do not use the 
defaults, you may want to increase some of these 
parameter values to allow for optional background 
processes. 

RECOVERY_PARALLELISM To speed up the roll forward or cache recovery phase, 
you can set this parameter. 

ROLLBACK_SEGMENTS Specify the private rollback segments for each 
instance. 

THREAD If specified, this parameter must have unique values 
for different instances. 

CACHE_SIZE_THRESHOLD GC_ROLLBACK_SEGMENTS 

CONTROL_FILES GC_SAVE_ROLLBACK_LOCKS 

CPU_COUNT GC_SEGMENTS 

DB_BLOCK_SIZE GC_TABLESPACES 

DB_FILES LOG_FILES

DB_NAME MAX_COMMIT_PROPAGATION_DELAY 

DELAYED_LOGGING_BLOCK_CLEANOUTS PARALLEL_DEFAULT_MAX_INSTANCES 

Parameter Parallel Server Notes
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Parameter Descriptions

Location of Initialization Files
The database for which the instance is started must have access to the appropriate 
initialization parameter files. By default, Enterprise Edition uses the initialization 
parameter files located in ORACLE_HOME\OPS unless you specify a different 
initialization file with the PFILE option at startup. 

Editing Initialization Files
To customize Oracle Parallel Server databases functions, you need to edit the 
initialization parameter files. Use any ASCII text editor to modify the file.

DML_LOCKS (must be identical only if set to 
zero) 

PARALLEL_DEFAULT_MAX_SCANS 

GC_DB_LOCKS PARALLEL_DEFAULT_SCANSIZE 

GC_FILES_TO_LOCKS ROLLBACK_SEGMENTS

GC_FREELIST_GROUPS ROW_LOCKING 

GC_LCK_PROCS SERIALIZABLE 

GC_ROLLBACK_LOCKS 

Additional Information: The following sections of the Oracle7 
Parallel Server Concepts and Administration Guide include 
descriptions of the initialization parameters: 

■ Chapter 19, “Administering Multiple Instances”

■ Appendix B, “Initialization Parameters” 
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Starting and Stopping Instances with Oracle Parallel 
Server Manager

Although instances can be started and stopped individually from each node using 
Server Manager, it is not always the most efficient way. Oracle Parallel Server 
allows you to start and stop one or more instances from one node or from an Oracle 
Enterprise Manager (EM) console workstation, thus centralizing the management 
of instances.

Instance management for Oracle Parallel Server is handled by Oracle Parallel 
Server Manager (OPSM). OPSM is comprised of the OPSCTL utility for Oracle EM. 
This utility is run directly from the command line on a node, or called by the Oracle 
EM’s agent when managing instances from the Oracle EM. OPSCTL is able to 
manage instances from an single entry point, because a background thread named 
OPSD (which runs on each node) receives OPSCTL’s requests, performs it, and 
send the results back to OPSCTL. 

WARNING: If your vendor does not support the OSD 
Performance and Management component, and you were not 
able to create configuration files with OPSCONF (as described in 
“Using OPSCONF” in Chapter 5, “Configuring”), you will not 
able to use OPSCTL. 
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Figure 7–4 shows how OPSCTL operates between the agent and OPSD:

Figure 7–4 OPSCTL Architecture

Understanding OPSCTL Requirements

OPSCTL requires the following:

■ Each SID of an instance of the Parallel Server is unique within an Oracle 
Parallel Server.

■ The TNSNAMES.ORA file on the node where OPSCTL.EXE is running must 
contain an entry for each instance of Oracle Parallel Server. The name of each 
service must be exactly the same as the Oracle SID for that instance (and 
exactly the same as they appear in the registry).

■ The database initialization files must follow a format of INITSID.ORA and be 
located in the ORACLE_HOME\OPS directory.

■ The database initialization files for all instances of your Oracle Parallel Server 
must exist on the node where OPSCTL.EXE is run.

Note: The following requirements are met if you followed all the 
steps in Chapter 5, “Configuring” and Chapter 6, “Installing and 
Configuring Oracle Enterprise Manager”.

Node 1
EM Console OPSD

OPSDOPSCTLAgent

Node 2

Node n
OPSD
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■ A new Windows NT user with the same name as the one you are using to 
access your Oracle EM console workstation must be created on all nodes of 
your Oracle Parallel Server. 

OPSCTL.EXE uses this user to start services on remote machines, so this user 
must have the equivalent of administrator access on each of the nodes. You can 
either use the default Oracle EM credential to access your Oracle Parallel 
Server or supply a different account name/password combination when 
creating a startup/shutdown job. In either case, the account used must have 
DBA privileges on an instance of Oracle Parallel Server in order to start or stop 
that instance.

Managing Instances from One Node
The OPSCTL.EXE utility allows you to manage all Oracle Parallel Server instances 
from each node. You can choose to start or stop all instances on an individual node.

Startup
OPSCTL START Command Line Usage

OPSCTL START -Cconnect string -N database name  [-ISID, SID] [-F] [-T] [-U] [-M] 
[-Y|-E] [-v] [-h]

where:

Note: [] indicates optional items.

Parameter Specifies

-Cconnect string connect string, such as INTERNAL/MANAGER

-Ndatabase name name of the Oracle Parallel Server database name to start; 
defined in the INIT_COM.ORA file

-ISID, SID to start specified instance(s) only

-F startup of instances following an ABORT shutdown; default is 
IMMEDIATE

-T RESTRICTED SESSION privileges only

-U database not to be mounted upon startup

-M mount, but do not open the database
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To start all instances:

C:\>CD ORACLE_HOME\BIN
C:\>OPSCTL START -CINTERNAL/MANAGER -Ndatabase name

To start an individual instance:

C:\>CD ORACLE_HOME\BIN
C:\>OPSCTL START -ISID -CINTERNAL/MANAGER -Ndatabase name

Shutdown
OPSCTL STOP Command Line Usage

OPSCTL STOP -Cconnect string -Ndatabase name  [-ISID, SID] [-F] [-T] [-U] [-M] 
[-v] [-h]

where:

-Y retry database opening if recovery is in progress

-E EXCLUSIVE mount and open

-v verbose

-h print usage

Note: [] indicates optional items.

Parameter Specifies

-Cconnect string connect string, such as INTERNAL/MANAGER

-Ndatabase name name of the Oracle Parallel Server database name to stop; 
defined in the INIT_COM.ORA file

-ISID, SID to stop specified instance(s) only

-F shutdown of instances in ABORT mode; default is IMMEDIATE

-T RESTRICTED SESSION privileges only

-U database not to be mounted upon startup

-M NORMAL mode of shutdown; default is IMMEDIATE

Parameter Specifies
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To stop all instances:

C:\>CD ORACLE_HOME\BIN
C:\>OPSCTL STOP -CINTERNAL/MANAGER -Ndatabase name

To stop an individual instance:

C:\>CD ORACLE_HOME\BIN
C:\>OPSCTL STOP -ISID -CINTERNAL/MANAGER -Ndatabase name

Managing Instances from Oracle EM
The OPSCTL.EXE utility is also invoked from the Oracle EM console workstation 
whenever an instance or multiple instances are started or stopped by:

■ right-clicking the mouse on a parallel server, and choosing either Startup or 
Shutdown from the Navigator tree

■ executing an Oracle Parallel Server start up/shut down job from the Job menu.

-v verbose

-h print usage

Additional Information: See Chapter 2, “Oracle Parallel Server 
Support”, in the Oracle Parallel Server Support for the Oracle 
Enterprise Manager Console and the Oracle Enterprise Manager 
Administrator’s Guide for further information about managing 
Oracle Parallel Servers and parallel server instances from Oracle 
EM.

Parameter Specifies
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8
Handling Migration Issues

This chapter describes how to add a third or fourth node to an existing two or three 
node configuration, and how to convert from a single instance Oracle7 database to 
a multi-instance Oracle7 database using the parallel server option

Specific topics covered in this chapter are:

■ Moving from a Single Instance to Parallel Server

■ Adding Additional Nodes to a Cluster
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Moving from a Single Instance to Parallel Server
This section explains how to migrate from a single instance Oracle7 database to 
multi-instance. In addition, it can help you extend an existing OPS configuration to 
additional nodes.

This section should be used as a supplement to Chapter 24, “Migrating from Single 
Instance to Parallel Server”, of the Oracle7 Parallel Server Concepts and Administration 
guide.

Step 1: Configure Hardware
See your vendor documentation for information about setting up Oracle Parallel 
Server hardware.

Step 2: Evaluate Tablespaces and Log Files of Single Instance
Because tablespaces must be identical on the Oracle Parallel Server as a single 
instance database, it is important that you do any consolidation, addition of, or 
renaming of tablespaces on the single instance at this time.

Each additional node in the cluster requires two log files. Typically, a single 
instance database only has two log files. You must add additional log files for each 
node using the ALTER DATABASE ADD LOGFILE statement.

Step 3: Create Raw Partitions
When building a database that is to be shared and managed by Oracle Parallel 
Server, it is necessary to access all disks as raw disks. In the case of a cluster, it is 
not possible to share a file system between two separate nodes. The file system is in 
effect a private cache resident on just one node.

The process of creating a raw disk involves creating an extended partition on a disk 
and assigning logical drives to it. 
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To create raw partitions:

1. Create raw partitions and assign logical drives, as described in Chapter 3, 
“Performing Pre-Installation Tasks”. Ensure enough raw partitions have been 
created for:

2. Assign meaningful symbolic link names to the logical drives, as described in 
“Step 1: Assign Symbolic Links to Each Logical Drive” of Chapter 5, 
“Configuring”. You may need to modify the ORALINK*.TBL files to suit your 
database.

Step 4: Install Oracle7 Server and Oracle Parallel Server Option
Except for the server already running Oracle7 Server, install the Oracle7 Server 
along with the Oracle Parallel Server option, as described in Chapter 4, 
“Installing”. If your current single instance database does not have the supporting 
hardware, you must perform a clean install on new cluster hardware.

On the server already running Oracle7 Server, install the Oracle Parallel Server 
Option:

To install the Oracle Parallel Server Option:

1. Install Oracle7 Server on the new nodes added to the cluster, following 
instructions in the installation CD-ROM insert and ensure you make the 
following choices:

1 Each node requires at least two log files.

File Type Number of Partitions Space Per Partition

control files 2 2 MB 

log files1 2 per node small # of transactions: 20-50K each

medium # of transaction: 200-500 K 
each

large # of transactions: 2 Mb - 5 Mb 
each
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a. Choose None in the Starter Database Options dialog box:

b. Choose Oracle7 Parallel Server Option from the Oracle7 Server Options 
dialog box:.

Step 5: Install OSD Files
For all nodes, see your Operating System Dependent (OSD) vendor documentation 
for instructions about installing OSD files.

Step 6: Export Data from Old Database
Export the entire database from the single instance database. Use one of the 
following tools:

■ Oracle Data Manager

■ Export Utility

Note: The location of the Oracle Home can be different on each of 
the nodes.
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Oracle Data Manager
To start Oracle Data Manager from the Enterprise Manager Console:

■ On Windows NT 3.51double-click the Data Manager icon in the Oracle 
Enterprise Manager Program Group

■ On Windows NT 4.0 choose View>Launch Palettes>Applications. The 
Applications palette appears. Click the Data Manager icon.

■ On Windows NT 4.0 choose Tools>Applications>Data Manager

Export Utility
Enter the following at the MS-DOS command prompt followed by your user name 
and password.

To use the Export utility to export all data from an existing database to the new 
database:

1. Set ORACLE_SID to the database service of the database whose contents you 
want to export. For example, export the starter database ORCL. Note there are 
no spaces around the equal sign (=) character.

C:\MYDIR> SET ORACLE_SID=ORCL 
2. Run the Export utility: 

C:\MYDIR> EXP73 SYSTEM/PASSWORD FILE=MYEXP.DMP FULL=Y LOG=MYEXP.LOG
 
You now have a full database export of the starter database ORCL in the file 
MYEXP.DMP, with all messages from the Export utility logged in the 
MYEXP.LOG file.

When running the Export utility, the default values for the following 
parameters under Windows NT are:

BUFFER 4 KB

RECORDLENGTH 2 KB

Additional Information: See Chapter 14, “Managing and Moving 
Data” of Oracle Enterprise Manager Administrator’s Guide

Note: To export an entire database, you must use the user name 
SYSTEM. Do not use INTERNAL or SYS.
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Step 7: Prepare CREATE DATABASE Script
A new database must be created on the raw partitions:

1. Use the BUILD_DB.SQL script located in 
ORACLE_HOME\RDBMS73\ADMIN to build a script:

Make the following changes to the BUILD_DB.SQL script:

a. Set PFILE so it points to the ORACLE_HOME\OPS\INITOPS1.ORA 
initialization file.

b. Modify the CREATE DATABASE ORACLE to CREATE DATABASE OPS.

c. Modify the log file and data file names with the symbolic link names you 
created in “Step 1: Assign Symbolic Links to Each Logical Drive” of 
Chapter 5, “Configuring”.

d. Modify the log file and data files with a naming convention of 
\\.\symbolic_link_name. The symbolic link name should match the name 
you used in ORALINK*.TBL file, as described in “Step 3: Create Raw 
Partitions”.

e. Create new entries for additional log files for each additional node. (Each 
node requires two log files. 

f. Modify the log file and data file sizes for the Oracle Parallel Server.

Enter the following command to find out the current size of data files:

SELECT * FROM DBA_DATA_FILES

g. Create enough private (acquired explicitly by an instance when an instance 
opens a database) rollback segments (16 is the default) for the number of 
concurrent users per transaction. With the exception of the SYSTEM 
rollback segment, public rollback segments cannot be shared among nodes.

A sample script follows:

create database ops
    controlfile reuse
    logfile GROUP 1 ’\\.\OPS_log1t1’size 200K reuse,
            GROUP 1 ’\\.\OPS_log2t1’size 200K reuse,
            GROUP 2 ’\\.\OPS_log1t2’size 200K reuse,
            GROUP 2 ’\\.\OPS_log2t2’size 200K reuse,
    datafile ’\\.\OPS_sys01’ size 50M,
    character set WE8ISO8859P1;

create rollback segment rb_temp;
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create tablespace user_data
    datafile ‘\\.\OPS_usr01’ size 15M;
create tablespace rollback_data
    datafile '\\.\OPS_rbs01' size 50M;
create tablespace temporary_data
    datafile '\\.\OPS_tmp01' size 10M;
alter rollback segment rb_temp online;

-- Change the SYSTEM users’ password, default tablespace and
-- temporary tablespace.

alter user system temporary tablespace temporary_data;
alter user system default tablespace user_data;

-- Create 16 rollback segments.  Allows 16 concurrent users with open
-- transactions updating the database. This should be enough.

create private rollback segment rb1 storage(initial 50K next 50K)
  tablespace rollback_data;
create private rollback segment rb2 storage(initial 50K next 50K)
  tablespace rollback_data;
create private rollback segment rb3 storage(initial 50K next 50K)
  tablespace rollback_data;
create private rollback segment rb4 storage(initial 50K next 50K)
  tablespace rollback_data;
create private rollback segment rb5 storage(initial 50K next 50K)
  tablespace rollback_data;
create private rollback segment rb6 storage(initial 50K next 50K)
  tablespace rollback_data;
create private rollback segment rb7 storage(initial 50K next 50K)
  tablespace rollback_data;
create private rollback segment rb8 storage(initial 50K next 50K)
  tablespace rollback_data;
create private rollback segment rb9 storage(initial 50K next 50K)
  tablespace rollback_data;
create private rollback segment rb10 storage(initial 50K next 50K)
  tablespace rollback_data;
create private rollback segment rb11 storage(initial 50K next 50K)
  tablespace rollback_data;
create private rollback segment rb12 storage(initial 50K next 50K)
  tablespace rollback_data;
create private rollback segment rb13 storage(initial 50K next 50K)
  tablespace rollback_data;
create private rollback segment rb14 storage(initial 50K next 50K)
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  tablespace rollback_data;
create private rollback segment rb15 storage(initial 50K next 50K)
  tablespace rollback_data;
create private rollback segment rb16 storage(initial 50K next 50K)
  tablespace rollback_data;

Step 8: Configure OSD Layer, Create Services, and Configure Network
Follow “Step 2: Configure OSD Layer” to “Step 5: Configure the Network” in 
Chapter 5, “Configuring”.

Step 9: Create an Oracle Parallel Server Database
To create a database:

1. On the primary node, start the database in exclusive mode, and run the 
CREATE DATABASE script you just created along with the following scripts:

C:\>SVRMGR23
SVRMGR>CONNECT INTERNAL/ORACLE
SVRMGR>STARTUP PFILE=C:%ORACLE_HOME%\OPS\INITOPS1.ORA 
SVRMGR> @%ORACLE_HOME%\RDBMS73\ADMIN\create_database.SQL
SVRMGR> @%ORACLE_HOME%\RDBMS73\ADMIN\CATALOG.SQL
SVRMGR> @%ORACLE_HOME%\RDBMS73\ADMIN\CATPROC.SQL
SVRMGR> @%ORACLE_HOME%\RDBMS73\ADMIN\CATPARR.SQL

2. If you modified the number of rollback segments, change the 
ORACLE_HOME\DATABASE\INITSID.ORA files to reflect the change.

3. Shut down the database.

SVRMGR>SHUTDOWN

CATALOG.SQL Generates the data dictionary.

CATPROC.SQL Installs the objects used by the Oracle7 
database's PL/SQL functionality.

CATPARR.SQL Creates objects for Oracle Parallel Server.
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Step 10: Transfer Data From Old Data to Empty Database
Import the entire database into the empty database. Use one of the following tools:

■ Oracle Data Manager

■ Import Utility

Oracle Data Manager
To start Oracle Data Manager from the Enterprise Manager Console:

■ On Windows NT 3.51double-click the Data Manager icon in the Oracle 
Enterprise Manager Program Group

■ On Windows NT 4.0 choose View>Launch Palettes>Applications. The 
Applications palette appears. Click the Data Manager icon.

■ On Windows NT 4.0 choose Tools>Applications>Data Manager

Import Utility
To import the full export created in the section “Step 6: Export Data from Old 
Database” into the new database:

Run the Import utility:

C:\MYDIR> IMP73 SYSTEM/PASSWORD FILE=MYEXP.DMP FULL=Y LOG=MYIMP.LOG  

Additional Information: See Chapter 14, “Managing and Moving 
Data” of Oracle Enterprise Manager Administrator’s Guide
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When running the Import utility, the default values for the following parameters 
under Windows NT are:

BUFFER 4 KB
RECORDLENGTH 2 KB

Step 11: Start the Database in Parallel Mode
See “Step 7: Start the Database in Parallel Mode” in Chapter 5, “Configuring” to 
start the Oracle Parallel Server.

IMPORTANT: If the original database from which the export file 
was generated contains tablespaces that are not in the new 
database, then the Import utility attempts to create those 
tablespaces with associated data files. The easy solution is to 
ensure both databases contain the same tablespaces. The data 
files do not have to be identical. Only the tablespace names are 
important.
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Adding Additional Nodes to a Cluster
This release of Oracle Parallel Server supports up to four nodes in a cluster. If you 
have already configured a two- or three-node cluster and want to add nodes three 
and/or four, you must add the new configuration information for these nodes 
through scripts. The database does need to be recreated.

Step 1: Create Additional Logical Drives 
Each additional node requires two log files. Because of this, you must add two 
additional logical drives for each additional node.

To create additional logical partitions:

1. Shut down all nodes except the primary node.

2. On the primary node, choose Start>Programs>Administrative Tools>Disk 
Administrator.

The Disk Administrator window appears.

3. On the primary node, select an area of free space in an extended partition by 
clicking the mouse on it.

4. Choose Create from the Partition menu.

The Disk Administrator window displays the minimum and maximum sizes for 
the logical drive.

5. Enter the size of the logical drive, and then choose OK. The size is dependent 
on how large your want your log files and data files to be. Add 2MB to this size 
for overhead.

6. Repeat Steps 3-5 until you have created enough drives.

You will need to create two drives for one additional node, or four drives for 
two additional nodes.

7. Choose Commit Changes Now from the Partition menu.

A confirmation dialog appears, informing you changes have been made to the 
disk.

Additional Information: See “Step 6: Create an Oracle Parallel 
Server Database” in Chapter 5, “Configuring”, for more 
information about OPS.SQL.
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8. Choose Yes to acknowledge the change.

A dialog box appears, informing you the disks have been updated successfully.

9. Choose OK.

10. Choose Close from the Partition menu.

11. Reboot all of the other nodes.

12. Choose Start>Programs>Administrative Tools>Disk Administrator on all the 
nodes.

On all nodes except the primary node, a dialog box appears, informing you the 
disk configuration has been detected. If you do not see this dialog box, it does 
not mean the disk configuration has not changed.

13. Choose OK.

The new logical partitions are now seen by all of the nodes.

Step 2: Unassign Drive Letters 
To unassign drive letters: 

1. On each node, select one of the new logical partitions.

2. Choose Assign Drive Letter from the Tools menu

The Assign Drive Letter dialog box appears:

3. Choose Do not assign a driver letter and choose OK.

A confirmation dialog box appears.

4. Choose Yes to confirm change.

5. Repeat Steps 1-4 for each of the new logical partition on each node, ensuring the 
logical partition assignments are identical to those of the primary node. 
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6. For each node in the cluster, write down the hard disk number(s) and the 
number of the partition (starting at 1) for that drive. 

Oracle Corporation recommends using a worksheet similar to the one below:

7. Choose Close from the Partition menu on all nodes.

The Disk Administrator application exits.

Note: The hard disks that access the shared area may be different 
from node to node. The logical drives, however, that reside on the 
hard disks must be identical from node to node.

Node 3 Node 4

Hard Diskx Partitions x-x Partitions x-x

Hard Diskx Partitions x-x Partitions x-x
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Step 3: Assign Symbolic Links to Each Logical Drive
Use the SETLINKS utility to create symbolic links to the new logical partitions. The 
SETLINKS utility uses a file named ORALINK2.TBL for the third node in a cluster 
and ORALINK3.TBL for the fourth node in a cluster. These files will create the 
symbolic links to the log files’ logical partitions:

Figure 8–1 ORALINK2.TBL

Figure 8–2 ORALINK3.TBL

To create symbolic links to a raw partition:

1. On the primary node, edit the partition and hard disk numbers appropriately in 
the ORALINK2.TBL file (for the third node) and ORALINK3.TBL (for the 
fourth node) located in ORACLE_HOME\OPS to match the disk numbers and 
partitions number you wrote down in section “Step 2: Unassign Drive Letters”. 

You can use a worksheet similar the one below to assist with the edits:

Symbolic Link Node 3

OPS_log1t3 Harddiskx Partitionx

OPS_log2t3 Harddiskx Partitionx

Symbolic Link Node 4

OPS_log1t4 Harddiskx Partitionx

OPS_log2t4 Harddiskx Partitionx

Additional Information: See Chapter 3, “Performing Pre-
Installation Tasks”, for further information about the Disk 
Administrator.

OPS_log1t3 \Device\Harddiskx\Partitionx
OPS_log2t3 \Device\Harddiskx\Partitionx

OPS_log1t4 \Device\Harddiskx\Partitionx
OPS_log2t4 \Device\Harddiskx\Partitionx
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2. Run the ORALINK2.TBL and/or ORALINK3.TBL through the SETLINKS 
application as shown below:

C:\>CD ORACLE_HOME\OPS
C:\ORACLE_HOME\OPS>SETLINKS /F:ORALINK2.TBL

C:\ORACLE_HOME\OPS>SETLINKS /F:ORALINK3.TBL

The symbolic links are created:

Oracle Corporation. Copyright (c) 1997. All rights reserved.
Created Link:OPS_log1t3 = Device:\Device\Harddisk3\Partition15
Created Link:OPS_log2t3 = Device:\Device\Harddisk3\Partition16
Dos devices updated successfuly.

3. Make sure the drives have been mapped with the correct names with the 
SETLINKS application (as shown below):

C:\ORACLE_HOME\OPS>SETLINKS /D

4. Repeat Steps 1-3 on the other nodes.

WARNING: Do not change the symbolic link names in 
OPSLINK1.TBL. If you do, symbolic link names must be 
modified for the following files located in 
ORACLE_HOME\OPS:

■ OPS.SQL

■ INITSID.ORA

■ INIT_COM.ORA
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Step 4: Shut Down Services
Some vendors may require you stop the services and stop the Cluster Manager. See 
your vendor documentation for further information.

To stop the services:

Stop OracleServiceSID, OracleTNSListener and OracleAgent services on each node:

■ From the MS-DOS command line, enter:

C:\>NET STOP service

■ From the Control Panel’s Services window, select the service, then choose Stop.

Step 5: Re-Configure OSD Layer

To configure the OSD components:

See your OSD vendor documentation for instructions about re-configuring the OSD 
components, making sure:

■ the domain name you specify is identical to the database name defined in the 
INIT_COM.ORA file located in ORACLE_HOME\OPS. The database name is 
defaulted to OPS

■ the machine names you specify are alpha-numeric 

Note: When following the steps below, note that some tasks are 
performed on the primary node only, while other tasks are 
performed on each node.

CAUTION: When configuring domains, two instances cannot 
reside on the same machine and be in the same domain. 



Adding Additional Nodes to a Cluster

                                                                   Handling Migration Issues 8-17

Step 6: Create Services
After the OSD components have been configured, OracleServiceSID for each 
instance must be created.

To create OracleServiceSID:

1. On the new node(s), go to the ORACLE_HOME\BIN directory:

C:\>CD ORACLE_HOME\BIN

2. Use the CRTSRV batch file to create a service corresponding to the instance of 
the node. 

C:\ORACLE_HOME\BIN>CRTSRV SID

For example, to create OracleServiceOPS2 on the third node:

C:\ORACLE_HOME\BIN>CRTSRV OPS3

3. Verify OracleServiceSID exists by choosing Services from the Control Panel.

The Services window appears:

4. Some vendors may require changing the password for OracleServiceSID and 
OracleTNSListener to the Administrator’s password for the machine:

a. Double-click the service. 
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The Service dialog box appears:

b. Choose the This Account option button.

c. Choose the “...” button.

The Add User dialog box appears:

d. Choose Administrator from the Names list box and choose Add.

e. Choose OK.

The Service dialog box reappears.
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f. Enter the NT administrator’s password in the Password and Confirm 
Password fields.

g. Choose OK.

The Services window reappears.

h. Choose Close to exit the Services window.

Step 7: Add the ORACLE_SID Entry to the Registry
The SID for an instance must be set in the registry to allow for instance recognition 
when you access a database from a node. When you connect to a database, Oracle 
Parallel Server will be able to resolve the SID name. 

Oracle Parallel Server requires the ORACLE_SID registry value to be manually 
added to the following location:

HKEY_LOCAL_MACHINE\Software\ORACLE

To add the ORACLE_SID registry value:

1. From each new node, start the registry in either one of two ways:

■ From the command line, enter:

C:\>REGEDT32

■ Select Run from the Start icon in the Taskbar, enter REGEDT32 in the Open 
field, and choose OK.

Note:  If the SID is not set in the registry, Oracle Parallel Server 
tries to see if the SID is set an environment variable. If it cannot 
find it, the SID name defaults to ORCL. ORCL is not a valid SID for 
an Oracle Parallel Server. Therefore, you will not be able to connect.
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The Registry Editor window appears:

2. Double-click the SOFTWARE key.

3. Click the ORACLE key.

4. Choose the Add Value option in the Edit menu.

The Add Value dialog box appears:
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5. In the Value Name field, enter ORACLE_SID.

6. In the Data Type box, select REG_SZ.

7. Choose OK.

The String Editor dialog box appears:

8. Enter the SID of the instance for the node you are on.

Registry Editor now adds ORACLE_SID. 

9. Choose Exit from the Registry menu.

The registry exits.

Step 8: Create New Configuration Files
To create new configuration files:

1. Use OPSCONF or SQL*Net Easy Configuration to create new configuration 
files, following the instructions in “Step 5: Configure the Network” in 
Chapter 5, “Configuring”.

2. Continue to “Step 9: Create Additional Rollback Segments For New Nodes”.
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Step 9: Create Additional Rollback Segments For New Nodes
1. On each node, delete the C:\DLM\SID\LOGS\DLM.LOG file.

2. Ensure OraclePGMSService service is running on each node (it should have 
already been started at boot time):

a. From the Control Panel window, double-click Services. 

b. Look for OraclePGMSService in the Services window. A blank in Status 
column indicates that the service is not running. If the service is already 
running, close the dialog box and go to Step 3. If the service is not running, 
go to Step c.

c. Start OraclePGMSService:

• From the MS-DOS command line, enter:

C:\>NET START OraclePGMSService

• From the Control Panel’s Services window, select OraclePGMSService, 
then choose Start.

3. Start OracleServiceSID on each node. 

■ From the MS-DOS command line, enter:

C:\>NET START OracleServiceSID

■ From the Control Panel’s Services window, select OracleServiceSID, then 
choose Start.

Starting these service starts the DLM for each of the nodes. 

4. On each node, ensure there is a Reconfiguration complete message in the 
C:\DLM\SID\LOGS\DLM.LOG file for the correct number of nodes, 
signifying the cluster was started without errors. This may take a few minutes.

Below is a sample of the log file, indicating successful startup for three nodes:

############################################################################
BEGIN LOG - Thu May 22 16:13:26 1997
16:13:32-312-00139- Reconfiguration started: Thu May 22 16:13:32 1997
16:13:39-296-00139- List of nodes: 0,1,2
...
16:13:47-468-00139- Reconfiguration complete: Thu May 22 16:13:47 1997

If you did not receive this message, check the 
C:\DLM\SID\OGS\DLMSTART.LOG.
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5. On the primary node, start the database, and run the C_OPS3.SQL (for the third 
node) and/or C_OPS4.SQL (for the fourth node) scripts:

C:\>SVRMGR23
SVRMGR>CONNECT INTERNAL/ORACLE
SVRMGR>STARTUP PFILE=C: %ORACLE_HOME%\OPS\INITOPS1.ORA PARALLEL
SVRMGR>@C_OPSx.SQL

The C_OPSx.SQL script creates the necessary rollback segments for the third 
and fourth nodes.

6. Stop OracleServiceSID:

■ From the MS-DOS command line, enter:

C:\>NET STOP OracleServiceSID
■ From the Control Panel’s Services window, select OracleServiceSID, then 

choose Stop.

Step 10: Start the Database in Parallel Mode
To start the Oracle Parallel Server database in parallel mode:

1. On each node, delete the C:\DLM\SID\LOGS\DLM.LOG file.

This file is re-created with new Oracle Parallel Server messages.

2. Ensure the OraclePGMSService service is running on each node (it should have 
already been started at boot time):

a. From the Control Panel window, double-click Services. 

b. Look for OraclePGMSService in the Services window. A blank in Status 
column indicates that the service is not running. If the service is already 
running, close the dialog box and go to Step 3. If the service is not running, 
go to Step c.

c. Start OraclePGMSService:

• From the MS-DOS command line, enter:

C:\>NET START OraclePGMSService

• From the Control Panel’s Services window, select OraclePGMSService 
service, then choose Start.
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3. Start OracleServiceSID on each node. 

■ From the MS-DOS command line, enter:

C:\>NET START OracleServiceSID

■ From the Control Panel’s Services window, select OracleServiceSID, then 
choose Start.

Starting these service starts the DLM for each of the nodes.

4. On each node, ensure there is a Reconfiguration complete message in the 
C:\DLM\LOGS\DLM.LOG file for the correct number of nodes, signifying the 
cluster was started without errors. 

Below is a sample of the log file, indicating successful startup for three nodes:

############################################################################
BEGIN LOG - Thu May 22 16:13:26 1997
16:13:32-312-00139- Reconfiguration started: Thu May 22 16:13:32 1997
16:13:39-296-00139- List of nodes: 0,1,2
...
16:13:47-468-00139- Reconfiguration complete: Thu May 22 16:13:47 1997

5. On the primary node, start the database:

C:\>SVRMGR23
SVRMGR>CONNECT INTERNAL/ORACLE@OPS1
SVRMGR>STARTUP PFILE=C:ORACLE_HOME\OPS\INITOPS1.ORA PARALLEL

6. On the remaining nodes, start the database:

C:\>SVRMGR23
SVRMGR>CONNECT INTERNAL/ORACLE
SVRMGR>STARTUP PFILE=C:ORACLE_HOME\OPS\INITSID.ORA PARALLEL
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Step 11: Verify Instances Are Running
To verify instances are running:

1. On any node, enter the following:

C:\>SVRMGR23
SVRMGR>CONNECT INTERNAL/ORACLE
SVRMGR>SELECT * FROM V$ACTIVE_INSTANCES;
The following output is returns:

INST_NUMBRE  INST_NAME
-----------  ---------
           1 node1:ops1
           2 node2:ops2
           3 node3:ops3
. . .

2. On all the nodes, connect as SCOTT/TIGER, view the EMP table.

C:\>SVRMGR23
SVRMGR>CONNECT SCOTT/TIGER
SVRMGR>SELECT * FROM EMP;

The employee table displays:

    EMPNO ENAME      JOB             MGR HIREDATE        SAL      COMM    DEPTNO
--------- ---------- --------- --------- --------- --------- --------- ---------
     7369 SMITH      CLERK          7902 17-DEC-80       800                  20
     7499 ALLEN      SALESMAN       7698 20-FEB-81      1600       300        30
     7521 WARD       SALESMAN       7698 22-FEB-81      1250       500        30
     7566 JONES      MANAGER        7839 02-APR-81      2975                  20
     7654 MARTIN     SALESMAN       7698 28-SEP-81      1250      1400        30
     7698 BLAKE      MANAGER        7839 01-MAY-81      2850                  30
     7782 CLARK      MANAGER        7839 09-JUN-81      2450                  10
     7788 SCOTT      ANALYST        7566 19-APR-87      3000                  20
     7839 KING       PRESIDENT           17-NOV-81      5000                  10
     7844 TURNER     SALESMAN       7698 08-SEP-81      1500         0        30
     7876 ADAMS      CLERK          7788 23-MAY-87      1100                  20
     7900 JAMES      CLERK          7698 03-DEC-81       950                  30
     7902 FORD       ANALYST        7566 03-DEC-81      3000                  20
     7934 MILLER     CLERK          7782 23-JAN-82      2300                  10
14 rows selected.

CAUTION: If another node is reconfigured after this table has 
been accessed and this statement is issued again, only the last 
node whose database was started displays.
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3. On the one node, connect increase MILLER’s salary by $1000 and commit the 
change:

SVRMGR>UPDATE EMP
SET SAL = SAL + 1000
WHERE ENAME = ‘MILLER’;
SVRMGR>COMMIT;

4. On the other nodes, select the EMP table again:

SVRMGR>SELECT * FROM EMP
MILLER’s salary should now be $3,300, indicating the all the instances can see 
the database.

Step 12: Reconfigure Performance Manager
Reconfiguring the Performance Manager involves re-running the OPS_MON.SQL. 
OPS_MON.SQL executes the following SQL scripts:

If you used OPSCONF to generate the configuration files in section “Using 
OPSCONF” in Chapter 5, “Configuring”, the OPS_DBL.SQL script will already be 
regenerated correctly with database links to the additional node(s). If OPSCONF 
was not used, OPS.DBL.SQL must be modified with the database links to the new 
node(s).

To reconfigure the Performance Manager:

1. Check to see if ORACLE_HOME\OPS\\OPS_DBL.SQL has been regenerated 
on the node where OPSCONF was run (if at all).

If it has been regenerated, go to Step 3.

If it the old OPS_DBL.SQL script still exists (indicating OPSCONF was not 
run), go to Step 2. 

Script Description

OPS_PACK.SQL Contains a set of PL/SQL procedures that are executed by 
Performance Manager to aggregate results from all instances of 
the parallel server.

OPS_CTAB.SQL Contains a set of tables used to store the aggregated results.

OPS_DBL.SQL Contains database links for each instance of the parallel server.
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2. Modify the OPS_DBL.SQL script by:

■ Adding the following lines for the third node:

drop public database link ops@hostname_ops3
/
create public database link ops@hostname_ops3 using ’ops3’
/

■ Adding the following lines for the fourth node:

drop public database link ops@hostname_ops4
/
create public database link ops@hostname_ops4 using ’ops4’
/

3. Enter the following at the MS-DOS command line from any node:

C:\>CD ORACLE_HOME\OPS
C:\>SVRMGR23
SVRMGR>@OPS_MON.SQL

OPS_MON.SQL executes the following scripts:

■ OPS_PACK.SQL

■ OPS_CTAB.SQL

■ OPS_DBL.SQL

4. Ensure the database links have been created using the proper database name:

SELECT NAME FROM V$DATABASE;

If you configured the Oracle Parallel Server with the default scripts, OPS (the 
default name of the database) is returned to the screen.

5. Increase the OPEN_LINKS and DISTRIBUTED_TRANSACTAIONS parameters 
in the INIT_COM file by the number of instances in the parallel server: 

OPEN_LINKS Specifies the maximum number of concurrent open 
connections to remote databases in one session. The 
default is set to 4.

DISTRIBUTED_TRANS
ACTIONS

Specifies the maximum number of distributed transactions 
in which this database can concurrently participate. The 
default is set to 16.
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Once the scripts have been executed, Enterprise Manager Performance 
Manager can be invoked against any instance of the parallel server. 
Performance Manager will execute a PL/SQL procedure on this instance to 
query for performance data from all instances of the parallel server via 
database links, aggregating the results into a set of database tables, which are 
then displayed in graphical form by Performance Manager.

Note: By default these parameters are not stored in the 
INIT_COM.ORA file. To increase the value of these parameters, 
you must add them to the INIT_COM.ORA file.
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9
Backing Up and Recovering an Oracle

Parallel Server Database

This chapter describes how to back up and recover an Oracle Parallel Server.

Specific topic covered in this chapter is:

■ Backup and Recovery
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Backup and Recovery
Backup and recovery of an Oracle Parallel Server database is performed from one 
node of the cluster using the NT Backup Manager and the NT Recovery Manager. 

These applications operate in the same way for Oracle Parallel Server as Oracle7 
Server, except where noted below:

■ All instances in the cluster must be shut down before performing an off-line 
backup or recovery.

■ 4mm and 8mm tapes are supported for Oracle Parallel Server; the previous 
release of Oracle7 Server on Windows NT only supports 4mm.

■ The ORACLE_SID parameter must be set in the registry at 
HKEY_LOCAL_MACHINE\Software\ORACLE. 

■ The NT Recovery Manager requires the INITSID.ORA to be located in the 
ORACLE_HOME\DATABASE directory. INITSID.ORA is placed in 
ORACLE_HOME\OPS by default. To use the NT Recovery Manager, copy 
INITSID.ORA to ORACLE_HOME\DATABASE.

■ When performing an off-line backup, you must change the default file names 
to the symbolic link names, \\.\link name.

For example, you would click Files from the NT Backup Manager main dialog 
box:

Additional Information: See “Step 4: Add the ORACLE_SID Entry 
to the Registry” in Chapter 5, “Configuring”.
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Select each file type (Data Files, Log Files and Control Files), and enter the 
appropriate file name. File names should match the symbolic link names you 
used in the ORALINKx.TBL file(s): 

Additional Information: See “Step 1: Assign Symbolic Links to 
Each Logical Drive” in Chapter 5, “Configuring”.
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A
Directory Structure

Specific topic covered in this chapter is:

■ Understanding the Oracle Parallel Server Directory Structure
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Understanding the Oracle Parallel Server Directory 
Structure 

The Oracle Installer places all Oracle products for Windows NT into subdirectories 
of ORACLE_HOME. The actual directory names vary according to the different 
products you install.

The exception to this rule is the following directory, which is installed at the root 
directory:

The subdirectories of ORACLE_HOME contain the contents listed below:

Directory Name Contents

C:\DLM\SID\LOGS\DLM.LOG DLM log files

Directory Name Contents

\A2OWIZ15 Oracle Migration Wizard for Microsoft Access 
Wizard files

\AGENTBIN Oracle Intelligent Agent files

\BIN Oracle7 and Oracle Parallel Server executable, 
DLL, icon, and library files

\DATABASE Oracle7 Server initialization files

\DBS Oracle Toolkit II message files and other utility 
files

\MSHELP Windows help files

\NETWORK SQL*Net for Windows NT directory

See Oracle Network Products Release 7.3.4 Getting 
Started for Windows Platforms for additional 
information about the \NETWORK directory and 
its contents.

\NLSRTL73 loadable NLS files

\OPS Oracle Parallel Server initialization files and 
Oracle Parallel Server SQL scripts

\ORAINST files used by the Oracle Installer

\OTRACE73 Oracle Trace files.
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\PLSQL23 message files, SQL scripts, and demonstration 
files for PL/SQL

\PLUS33 SQL*Plus files

\PRO18 Pro*C/C++ files

\RDBMS73 Oracle7 Server message, resource, and readme 
files

Directory Name Contents
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B
Troubleshooting

Specific topics covered in this chapter are:

■ ORA-600 [9030]

■ Using PhysicalDrive for Raw Partitions

■ Performing SHUTDOWN

■ Distributed Lock Manager Log Files

■ Contacting Oracle Worldwide Customer Support
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ORA-600 [9030]
Cause:  This error message is displayed when DLM resources have been 
exceeded. DLM resources are the following parameters defined where your 
vendor has placed them:

■ MAXIMUM_LOCKS

■ MAXIMUM_PROCS

■ MAXIMUM_RESOURCES

Oracle Parallel Server expects the number of resource structures to be more 
than the number specified by all GC_* parameters in the INITSID.ORA file. 

Action:  Increase the values for MAXIMUM_LOCKS, MAXIMUM_PROCS and 
MAXIMUM_RESOURCES.

Using PhysicalDrive for Raw Partitions
When creating symbolic links for the logical drives with SETLINKS utility, do not 
use \\.\PhysicalDrive. If you use \\.\PhysicalDrive as a symbolic link, you can 
corrupt your system. Use the symbolic links provided in the ORALINKx.TBL 
file(s), as described in Chapter 5, “Configuring”. 

Performing SHUTDOWN
This section describes issues with:

■ SHUTDOWN NORMAL

■ SHUTDOWN ABORT

SHUTDOWN NORMAL
Do not perform SHUTDOWN NORMAL on more than one node at a time. 
Simultaneous SHUTDOWN NORMAL commands will cause the system to hang. If 
you need to bring down more than one node, be sure to complete one 
SHUTDOWN NORMAL at a time. This restriction also means that you should not 
use the Oracle Enterprise Manager console to perform a SHUTDOWN NORMAL 
on the database.

Additional Information: See your vendor documentation to find 
out where these OSD values are defined.
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SHUTDOWN ABORT
SHUTDOWN ABORT is not supported for nodes in a cluster. If you must perform 
a SHUTDOWN ABORT, shut down the OracleServiceSID in one of two ways:

■ From the MS-DOS command line, enter:
C:\>NET STOP OracleServiceSID

■ From the Control Panel’s Services window, select the OracleServiceSID service, 
then choose Stop.

Distributed Lock Manager Log Files
Oracle Distributed Lock Manager (DLM) log files are created in 
C:\DLM\SID\LOGS\DLM.LOG by default. If you want them written to another 

drive, you must add a LKMGR_LOG parameter with the new location to the 
HKEY_LOCAL_MACHINE\Software\ORACLE\PARALLEL_SERVER key in the 
registry.

Contacting Oracle Worldwide Customer Support

How to Contact Oracle Worldwide Customer Support
Oracle Worldwide Customer Support can be contacted as follows:

For further information on how to contact Oracle Worldwide Customer Support, 
see the included Customer Support Information Booklet.

Location Contact

United States of America Telephone (1) (650) 506-1500

Europe Telephone (1) (44) (1344) 860-160

Outside the United States and 
Europe

Your Oracle sales representative

Worldwide Visit: http://www.oracle.com/support/ 
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Glossary

cluster

A set of instances, each typically running on different nodes, that coordinate with 
one another when accessing the shared database residing on disk.

Cluster Manager

Operating System Dependent component that discovers and tracks the member-
ship state of nodes by providing a common view of cluster membership across the 
cluster. 

Distributed Lock Manager

Oracle Parallel Server software that provides locking mechanisms to control alloca-
tion and modification of Oracle resources. 

DLL

Dynamic Link Libraries. Microsoft Windows operating system executable files.

DLM

DLM is the abbreviation for the Distributed Lock Manager.

domain

A set of instances coordinating together that run on only the nodes defined within 
a cluster. Typically, a domain is composed of instances that run on some subset of 
those nodes. Multiple domains can exist with a cluster. Each domain defines the 
Oracle Parallel Server instance. Each domain name is typically the database name 
defined in the INIT_COM.ORA file.
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extended partition

A type of partitions that points to raw space on the disk. An extended partition can 
be assigned multiple logical drives for the database files. An extended partition 
avoids the four-partition limit by allowing you to define large numbers of logical 
partitions to accommodate applications using Oracle7 Server. 

fine-grain locking

A type of locking where one PCM lock per block is assigned on a dynamic basis.

hash locking

A type of locking where PCM locks are statically assigned to one or more blocks in 
the data files.

instance

A set of threads and resources required for proper database operation. The pool of 
threads that make up an instance coordinate their work on the database through 
shared memory by means of the Shared Global Area (SGA). All processes 
belonging to the instance exist on the same node. You can connect to any instance 
to access any information that resides within a parallel server database.

instance identifier

A name or ID used to distinguish one instance from another when multiple 
instances exist on one CPU. The identifier is specified in a operating system specific 
manner.

logical drive

Raw partition created by the Disk Administrator that points to a partition other 
than Partition0.

node

A Windows NT server where an instance resides.

listener

The server process that listens for and accepts incoming connection requests from 
client applications. Oracle listener processes start up Oracle database processes to 
handle subsequent communications with the client.

LISTENER.ORA

A configuration file that describes one or more TNS listeners on a server.
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Oracle Enterprise Manager

A product family consists of system management tools designed to efficiently man-
age the complete Oracle environment.

Oracle7 Database

The software used to create and maintain the database system, as well as the actual 
data stored in the database.

Oracle7 RDBMS

The Oracle Relational Database Management System. Oracle7 Server for Windows 
NT is an Oracle RDBMS.

Performance Manager

Oracle Enterprise Manager’s Performance Manager allows you to choose from a 
variety of tabular and graphic performance statistics for parallel servers. The 
statistics represent the aggregate performance for all instances running on a parallel 
server. The statistics are display in individual charts and include information on 
data block pings, lock activity, file I/O, and session and user information. 

OPSM

A single point for starting, stopping, and monitoring the activity of parallel servers 
and parallel server instances from the command line or from within Oracle 
Enterprise Manager (EM).

Oracle service

Created and associated with Oracle7 database. Similar to Windows NT services.

Operating System Dependent layer

A software layer that consists of several software components developed by 
vendors. The OSD layer maps the key OS/cluster-ware services required for proper 
operation of Oracle Parallel Server.

OPSCONF

A utility to generate configuration files and database links.

OPSCTL

A utility to start and stop instances from either one node or from Oracle Enterprise 
Manager.
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OSD

Abbreviation for Operating System Dependent.

Parallel Cache Management

Oracle Parallel Server software that provides instance locks that cover one or more 
data blocks (table or index blocks) in the buffer cache. PCM locks ensure that each 
shared buffer cache in a node remains consistent with the shared buffer caches in 
other nodes with minimal use of the DLM.

Parallel Query

Parallel query divides the work of processing certain types of SQL statements 
among multiple query server processes.

Parallel Coordinator Process

Parallel coordinator process dispatches the execution of a SQL statement to several 
parallel slave processes and coordinates the results from all of the slave processes to 
send the results back to the user. 

Parallel Slave Process

Parallel slave process performs the requested action of the parallel coordinator 
process.

Performance Manager

The Oracle Enterprise Manager’s Performance Manager allows you to choose from 
a variety of tabular and graphic performance statistics for parallel servers. The 
statistics represent the aggregate performance for all instances running on a parallel 
server. The statistics are display in individual charts and include information on 
data block pings, lock activity, file I/O, and session and user information. 

PCM

PCM is an abbreviation for Parallel Cache Management.

PGMS

PGMS monitors instances on the nodes in a cluster.

physical partition

Partition that points to Partition0. Window NT automatically creates a symbolic 
link name of \\.\PhysicalDrivex (where x is the physical drive number) to 
\Device\Harddiskx\Partition0. The x in \\.\PhysicalDrivex matches the x in 
\Device\Harddiskx\Partition0.
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primary partition

A partition into which you can install the files needed to load an operating system. 
A primary partition is usually formatted for a particular file system and is assigned 
a drive letter. There can be at most four primary partitions on a physical drive.

SID

A unique name for an Oracle database instance. To switch between Oracle 
databases, users must specify the desired SID. The SID is included in the 
CONNECT DATA parts of the connect descriptors in a TNSNAMES.ORA file, and 
in the definition of the network listener in the LISTENER.ORA file. Also known as 
system ID.

system ID

A synonym for instance identifier. Often abbreviated to SID.

SETLINKS

A utility to map symbolic links to logical partitions.

SQL*Net Easy Configuration

A GUI application to generate configuration files.

TOPOLOGY.ORA

Defines the parallel servers and instances in the network.

TNSNAMES.ORA

A file that contains connect descriptors mapped to service names. The file may be 
maintained centrally or locally, for use by all or individual clients.

tablespace

A logical portion of an Oracle database used to allocate storage for table and index 
data. Each tablespace corresponds to one or more physical database files. Every 
Oracle database has a tablespace called SYSTEM and may have additional 
tablespaces. A tablespace is used to group related logical structures together. For 
example, tablespaces commonly group all of an application’s objects to simplify 
certain administrative operations.

thread

The cross memory services connection from CICS to an Oracle for MVS subsystem 
for a particular Oracle user ID.
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Index
Symbols
\\.\PhysicalDrivex, 3-4, G-4
_ENABLE_DBA_LOCKING parameter, 1-8, 7-7

A
administering instances, 7-1–7-10

B
backup, 9-1–9-3

C
CACHE_SIZE_THRESHOLD parameter, 7-9
CATALOG.SQL script, 8-8
CATPARR.SQL script, 8-8
CATPROC.SQL script, 8-8
CHECKPOINT_PROCESS parameter, 7-8
Cluster Manager

defined, 1-12, G-1
described, 1-14

cluster, defined, 1-3, G-1
CM, defined, 1-12
configuration, 5-1–5-24
configuration files

create, 5-14
LISTENER.ORA, 5-13
testing, 5-18
TNSNAMES.ORA, 5-13
TOPOLOGY.OPS, 5-13
using OPSCONF, 5-14
using SQL*Net Easy Configuration, 5-16

configure
domains, 5-7, 8-16
Oracle Enterprise Manager, 6-1–6-21
OSD, 5-7, 8-16
Performance Manager, 6-16, 8-26
single instance to parallel server, 8-2–8-10
the network, 5-12, 8-21
third or fourth node, 8-11–8-28

CONTROL_FILES parameter, 7-9
Conventions

typographical, xvi
CPU_COUNT parameter, 7-9
CRTSRV batch file, 5-8

D
data files, 1-4
database creation, 5-19, 8-6
database files, 1-4
DB_BLOCK_SIZE parameter, 7-9
DB_FILES parameter, 7-9
DB_NAME parameter, 7-9
DBA_DATA_FILES, 8-6
DBWR process, 1-3
DELAYED_LOGGING_BLOCK_CLEANOUTS 

parameter, 7-9
DELAYED_LOGGING_BLOCK_

CLEANOUTS parameter, 7-8
directory structure, Oracle Parallel Server, A-1–A-3
disk definition, 3-4
disks, shared access, 1-5
Distributed Lock Manager, defined, 1-6, G-1
DISTRIBUTED_TRANSACTIONS parameter, 6-

19, 8-27
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DLL, defined, G-1
DLM

block access synchronization, 1-6
deadlock detection, 1-6
defined, 1-6, G-1
failure detection, 1-6
locking mechanism, 1-6
modification synchronization, 1-6

DLM.LOG file, 5-20, 5-22, A-2, B-3
DLMON, defined, 1-7
DLMSTART.LOG file, 5-20, 5-22
DML_LOCKS parameter, 7-8, 7-10
domain, defined, 1-3, G-1

E
export, 8-4
extended partition

create logical drives, 3-7, 8-11
creating, 3-5
defined, 3-2, G-2

F
fine-grain locking, 1-8, 7-8

_ENABLE_DBA_LOCKING, 1-8, 7-8
defined, G-2
when to use, 1-9

G
GB_FILES_TO_LOCKS parameter, 7-7
GB_LCK_PROCS parameter, 7-7
GC_DB_LOCKS parameter, 7-7, 7-10
GC_FILES_TO_LOCKS parameter, 7-10
GC_FREELIST_GROUPS parameter, 7-7, 7-10
GC_RELEASABLE_LOCKS parameter, 7-7
GC_ROLLBACK_LOCKS parameter, 7-7, 7-10
GC_ROLLBACK_SEGMENTS parameter, 7-7, 7-9
GC_SAVE_ROLLBACK_LOCKS parameter, 7-7, 7-

9
GC_SEGMENTS parameter, 7-7, 7-9
GC_TABLESPACES parameter, 7-8, 7-9
Global Constant Parameters, list, 7-7
Group Membership Service, defined, 1-5

H
hardware requirements, 2-2
hash locking, 1-8

defined, G-2
when to use, 1-9

I
IFILE parameter, 7-3, 7-4
INIT_COM.ORA, 5-5, 8-15

_ENABLE_DBA_LOCKING, 7-7
CACHE_SIZE_THRESHOLD, 7-9
CHECKPOINT_PROCESS, 7-8
CONTROL_FILES, 7-9
CPU_COUNT, 7-9
DB_BLOCK_SIZE, 7-9
DB_FILES, 7-9
DB_NAME, 7-9
DELAYED_LOGGING_BLOCK_CLEANOUTS,

7-9
DELAYED_LOGGING_BLOCK_

CLEANOUTS, 7-8
DISTRIBUTED_TRANSACTIONS, 6-19, 8-27
DML_LOCKS, 7-8, 7-10
GB_FILES_TO_LOCKS, 7-7
GB_LCK_PROCS, 7-7
GC_DB_LOCKS, 7-7, 7-10
GC_FILES_TO_LOCKS, 7-10
GC_FREELIST_GROUPS, 7-7, 7-10
GC_RELEASABLE_LOCKS, 7-7
GC_ROLLBACK_LOCKS, 7-7, 7-10
GC_ROLLBACK_SEGMENTS, 7-7, 7-9
GC_SAVE_ROLLBACK_LOCKS, 7-7, 7-9
GC_SEGMENTS, 7-7, 7-9
GC_TABLESPACES, 7-8, 7-9
Global Constant Parameters, 7-6
identical parameters, 7-9
INSTANCE_NUMBER, 7-8
LOG_ARCHIVE_FORMAT, 7-8
LOG_FILES, 7-9, 7-10
MAX_COMMIT_PROPAGATION_DELAY, 7-

8, 7-9
NLS_* parameters, 7-8
OPEN_LINKS, 6-19, 8-27
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PARALLEL_DEFAULT_MAX_INSTANCES, 7-
9

PARALLEL_DEFAULT_MAX_SCANS, 7-10
PARALLEL_DEFAULT_SCANSIZE, 7-10
parameter notes, 7-8
PROCESSES, 7-9
RECOVERY_PARALLELISM, 7-9
ROLLBACK_SEGMENTS, 7-9, 7-10
ROW_LOCKING, 7-10
SERIALIZABLE, 7-10
THREAD, 7-9

INITCOM.ORA, 7-3
initialization files, 7-1–7-10

definition, 7-2
editing, 7-10
for instances, 7-2
identical parameters, 7-9
INITCOM.ORA, 7-3
INITSID.ORA, 7-2
location, 7-9, 7-10

initialization parameters
descriptions, 7-10
editing, 7-10
Global Constant Parameters, 7-6
identical, 7-9
setting, 7-6

initialization parameters, setting, 7-6
INITSID.ORA, 5-5, 7-2, 8-15

IFILE, 7-4
INSTANCE_NUMBER, 7-4
ROLLBACK_SEGMENTS, 7-4
THREAD, 7-4

Input/Output
defined, 1-12
described, 1-15

install
OPSM Client, 4-2, 6-4
Oracle Enterprise Manager, 6-3
Oracle Parallel Server Manager, 4-2
Oracle Parallel Server Option, 4-2, 4-3, 8-3
Oracle7 Server, 4-3, 8-3
OSD, 4-4, 8-4
Performance Pack, 6-4
repository database, 6-3

installation, 4-1–4-4

installation requirements, 2-1
disk space, 2-4
hardware, 2-2
shared disk partitions, 2-4
software, 2-3

instance identifier (SID), defined, G-2
INSTANCE_NUMBER parameter, 7-4, 7-8
instances

administering, 7-1–7-10
defined, 1-4, G-2
identical parameters, 7-9
issues, 7-6
managing from one node, 7-13
managing from Oracle Enterprise Manager, 7-

15
setting initialization parameters, 7-6
shutdown, 7-14
starting and stopping, 7-11
starting from Oracle Enterprise Manager, 7-15
starting with OPSCTL, 7-13
stopping from Oracle Enterprise Manager, 7-15
stopping with OPSCTL, 7-14
verifying, 5-23, 8-25

Inter-Process Communication
defined, 1-12
described, 1-15

IO, defined, 1-12
IPC, defined, 1-12

L
LCK0 process, 1-3
LGWR process, 1-3
listener

defined, G-2
starting, 5-18
stopping, 5-13

LISTENER.ORA, 5-13, 5-17
LISTENER.ORA, defined, G-2
LKMGR_LOG parameter, add to registry, B-3
LOG_ARCHIVE_FORMAT parameter, 7-8
LOG_FILES parameter, 7-9, 7-10
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logical drives
assigning symbolic links, 5-2, 8-14
defined, G-2
unassigning drive letters, 3-11, 8-12

logical drives, creating, 3-7, 8-11
LSNRCTL utility

starting from the Control Panel, 5-19, 5-21, 6-6, 
8-22, 8-23

M
MAX_COMMIT_PROPAGATION_DELAY 

parameter, 7-8, 7-9
MAXIMUM_LOCKS parameter, B-2
MAXIMUM_PROCS parameter, B-2
MAXIMUM_RESOURCES parameter, B-2

N
network configuration, 5-12, 8-21
NLS_* parameters, 7-8
node, defined, G-2
NT Backup Manager, 9-1–9-3
NT Recovery Manager, 9-1–9-3
NT user account, creating, 6-8

O
OPEN_LINKS parameter, 6-19, 8-27
Operating System Dependent layer, G-3

components, 1-12
defined, 1-12

OPQ
defined, 1-10
issuing SQL statements, 1-11

OPS directory, A-2
OPS.SQL script, 5-5, 8-15
OPS_cntr01, 5-3
OPS_CTAB.SQL script, 6-17, 8-26
OPS_DBL.SQL script, 6-17, 8-26

create database links, 6-17, 8-26
creating from OPSCONF, 6-17, 8-26
creating manually, 6-17, 8-26

OPS_log1t1, 5-3
OPS_log1t2, 5-3

OPS_log2t1, 5-3
OPS_MON.SQL script, 6-17, 8-26
OPS_PACK.SQL script, 6-17, 8-26
OPS_rbs01, 5-3
OPS_sys01, 5-3
OPS_tmp01, 5-3
OPS_usr01, 5-3
OPSALL.SQL script, 5-20
OPSCONF utility, 5-12

defined, G-3
OPS_DBL.SQL script, 6-17, 8-26
using, 5-14

OPSCTL requirements, 7-12
OPSCTL START usage, 7-13
OPSCTL STOP usage, 7-14
OPSCTL utility

defined, G-3
managing from Oracle Enterprise Manager, 7-

15
managing instances, 7-13

OPSM
defined, 1-12, G-3
OPSCTL requirements, 7-12
starting and stopping instances, 7-11
using, 7-11–7-15
using OPSCTL, 7-13
using Oracle Enterprise Manager, 7-15

OPSM Client, 4-2, 6-4
OPSM Server, 4-2
ORA-600 (9030), B-2
Oracle Enterprise Manager

accessing and creating the repository, 6-12
configuration, 6-1–6-21
configuration steps, 6-5
creating a repository user account, 6-6
creating an Windows NT user account, 6-8
creating NT user account, 6-8
defined, G-3
install, 6-3
install Performance Pack, 6-4
install repository database, 6-3
OPSM, 1-12
OPSM Client, 6-4
overview, 6-2
start Oracle services, 6-6
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starting, 6-13
User Manager, 6-8
verifying Oracle Services, 6-6

Oracle home
defined, xvii

Oracle Network Products
directory structure, A-2

Oracle Parallel Query
defined, 1-10
issuing SQL statements, 1-11

Oracle Parallel Server
database files, 1-4
defined, 1-3
overview, 1-1–1-16

Oracle Parallel Server database
creating, 5-19, 8-6
creating rollback segments, 8-22
starting, 5-21, 8-10, 8-23

Oracle Parallel Server instances
verifying, 5-23, 8-25

Oracle Parallel Server Manager, 4-2
OPSCTL requirements, 7-12
starting and stopping instances, 7-11
using, 7-11–7-15
using OPSCTL, 7-13
using Oracle Enterprise Manager, 7-15

Oracle Parallel Server Manager, defined, 1-12
Oracle Parallel Server Option, 4-2
Oracle Parallel Server Option, installing, 4-3, 8-3
Oracle service, defined, G-3
ORACLE_HOME parameter, 1-3
ORACLE_SID parameter, 1-3

add to registry, 5-10, 8-19
Oracle7 Database, defined, G-3
Oracle7 RDBMS, defined, G-3
Oracle7 Server, installing, 4-3, 8-3
OraclePGMSService service, 1-5, 4-2, 5-19, 8-22
OracleServiceSID, creating, 5-8, 8-17
ORALINK*.TBL file, 8-3
ORALINK1.TBL file, 5-2
ORALINK2.TBL file, 5-2, 8-14
ORALINK3.TBL file, 5-3, 8-14
OSD

Cluster Manager (CM), 1-14
configure, 5-7, 8-16
defined, 1-12, G-4

Input/Output, 1-15
Inter-Process Communication (Node-to-

Node), 1-15
Performance and Management, 1-16
Startup, 1-16

OSD components, 1-12
OSD files, installing, 4-4, 8-4

P
P&M, defined, 1-12
Parallel Cache Management, 1-8
Parallel Cache Management, defined, G-4
parallel coordinator process, defined, G-4
parallel coordinator, defined, 1-10
PARALLEL option, 5-22, 8-8
Parallel Query, defined, G-4
parallel slave process, defined, 1-10, G-4
PARALLEL_DEFAULT_MAX_INSTANCES 

parameter, 7-9
PARALLEL_DEFAULT_MAX_SCANS 

parameter, 7-10
PARALLEL_DEFAULT_SCANSIZE parameter, 7-

10
partition

extended, 3-2
logical drive, 3-4
physical drive, 3-4
raw, 3-2

PCM
defined, G-4
fine-grain locking, 1-8
fine-grain locking usage, 1-9
hash locking, 1-8
hash locking usage, 1-9

Performance and Management
defined, 1-12
described, 1-16
OPSM, 1-16

Performance Manager
configure, 6-16, 8-26
defined, G-3, G-4
described, 6-16
OPS_CTAB.SQL, 6-17, 8-26
OPS_DBL.SQL, 6-17, 8-26
OPS_MON.SQL, 6-17, 8-26
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OPS_PACK.SQL, 6-17, 8-26
starting, 6-20

Performance Pack, installation, 6-4
PFILE option, 5-22, 7-10, 8-8, 8-23, 8-24
PGMS, defined, 1-5, G-4
physical partition, defined, G-4
PhysicalDrive, 3-4, B-2
PMON process, 1-3
pre-installation tasks, 3-1–3-12
primary node, defined, 1-3
primary partition, defined, G-5
PROCESSES parameter, 7-9

R
raw partition

creating, 8-2
defined, 3-2
logical drive, 3-4
overview, 3-2
physical drive, 3-4

raw partition definition, 3-4
recovery, 9-1–9-3
RECOVERY_PARALLELISM parameter, 7-9
REGEDT32, 5-10, 8-19
registry

adding LKMGR_LOG entry, B-3
adding ORACLE_SID entry, 5-10, 8-19

repository user account, 6-6
repository, creating for Oracle Enterprise 

Manager, 6-12
rollback segments, 8-22
ROLLBACK_SEGMENTS parameter, 7-4, 7-9, 7-10
ROW_LOCKING parameter, 7-10

S
SERIALIZABLE parameter, 7-10
services, create, 5-8, 8-17
SETLINKS utility, 5-2, 8-14

create symbolic links, 5-2, 8-14
defined, G-5
ignoring links, 5-6
OPS_cntr01, 5-3
OPS_log1t1, 5-3

OPS_log1t2, 5-3
OPS_log2t1, 5-3
OPS_rbs01, 5-3
OPS_sys01, 5-3
OPS_tmp01, 5-3
OPS_usr01, 5-3
removing links, 5-6

SGA, defined, 1-4, G-2
shared disk storage subsystem, 1-3, 2-4
shared disks, 1-5
Shared Global Area, defined, G-2
Shared Global Area,defined, 1-4
SHUTDOWN ABORT, B-3
SHUTDOWN NORMAL, B-2
SID, defined, 1-3, G-5
SID_DESC keyword, using, 5-18
SMON process, 1-3
software requirements, 2-3
SQL*Net Easy Configuration, defined, G-5
START, defined, 1-12
starting Oracle Parallel Server database, 5-21, 8-10, 

8-23
Startup

defined, 1-12
described, 1-16

support, contacting, B-3
symbolic link creation, 5-2, 8-14
symbolic link removal, 5-6
symbolic link, ignoring, 5-6
system ID, defined, G-5
system requirements, 2-1–2-4

T
tablespace, defined, G-5
THREAD parameter, 7-4, 7-9
thread, defined, G-5
TNSNAMES.ORA, 5-13
TNSNAMES.ORA, defined, G-5
TOPOLOGY.OPS, 5-13
TOPOLOGY.ORA, defined, G-5
troubleshooting, B-1–B-3
Typographical conventions, xvi
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U
unassign drive letters, 3-11, 8-12
User Manager, for Oracle Enterprise Manager, 6-8

V
V$ACTIVE_INSTANCES, 5-23, 8-25
V$DATABASE, 6-18, 8-27
V$PQ_SYSSTAT, 1-11

W
Windows NT user account, creating, 6-8
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